Copyright © 2016 by In-Situ All rights reserved.

This document contains proprietary information which is protected by copyright. No part of this document may be photocopied, reproduced, or translated to another language without the prior written consent of In-Situ.

Mailing and Shipping
Address: In-Situ
221 East Lincoln Avenue
Fort Collins, CO 80524
U.S.A.

Phone: 970-498-1500 (international & domestic)
Fax: 970-498-1598
Internet: www.in-situ.com
Support: 800-446-7488 (U.S.A. & Canada)

In-Situ makes no warranty of any kind with regard to this material, including, but not limited to, its fitness for a particular application. In-Situ will not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

In no event shall In-Situ Inc. be liable for any claim for direct, incidental, or consequential damages arising out of, or in connection with, the sale, manufacture, delivery, or use of any product.

In-Situ and the In-Situ logo, Win-Situ, TROLL, Baro Merge, BaroTROLL, HERMIT, HydroVu™, iSitu, Pocket-Situ, RDO, RuggedCable, RuggedReader, SmarTROLL™, TROLL, VuSitu™, and Win-Situ are trademarks or registered trademarks of In-Situ Inc. Microsoft and Windows are registered trademarks of Microsoft Corporation. Pentium is a registered trademark of Intel. Tefzel and Delrin are registered trademarks of E. I. DuPont de Nemours and Company. Viton is a registered trademark of DuPont Dow Elastomers. Kellems is a registered trademark of Hubbell Inc. Alconox is a registered trademark of Alconox Company. Lime-A-Way is a registered trademark of Reckitt Benckiser. Android is a trademark of Google Inc. iPod and iPhone are trademarks of Apple Inc., registered in the U.S. and other countries. The Bluetooth word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such marks by In-Situ Inc. is under license. NIST is a registered trademark of the National Institute of Standards and Technology, U.S.A. Other brand names and trademarks are property of their respective owners.

The presence of the Waste Electrical and Electronic Equipment (WEEE) marking on the product indicates that the device is not to be disposed via the municipal waste collection system of any member state of the European Union.

For products under the requirement of WEEE directive, please contact your distributor or local In-Situ office for the proper decontamination information and take back program, which will facilitate the proper collection, treatment, recovery, recycling, and safe disposal of the device.

0096402 | 2019-09-04
# Table of Contents

1 Introduction ........................................................................................................ 10
   Serial Number Location .................................................................................. 10
   Instrument Description ................................................................................... 10
   Document Conventions .................................................................................. 10
   Unpacking and Inspection .............................................................................. 10
   Obtaining Repair Service .............................................................................. 10
   Guidelines for Cleaning Returned Equipment .............................................. 11
   Decontamination and Cleaning Form ............................................................. 12
   Safety ............................................................................................................ 12

2 General Specifications ....................................................................................... 13
   Instrument Dimensions with Restrictor On .................................................... 15
   Instrument Dimensions with Restrictor Off .................................................... 15

3 Sensor Specifications ......................................................................................... 15
   Sensor Summary .............................................................................................. 15
   Potential Interferents ..................................................................................... 16
   RDO Cap Chemical Incompatibility ............................................................... 17
   Ammonium, Chloride and Nitrate Interferent Concentrations ......................... 17
      Ammonium ................................................................................................. 17
      Chloride .................................................................................................... 17
      Nitrate ...................................................................................................... 17
   Barometric Pressure Sensor Specifications ................................................... 18
   Conductivity Sensor Specifications ................................................................ 18
      Total Dissolved Solids ............................................................................. 19
      Salinity .................................................................................................... 19
   Dissolved Oxygen RDO Sensor Specifications ............................................. 19
   Level, Depth, Pressure Sensor Specifications ............................................... 20
   ORP Sensor Specifications ............................................................................. 20
   pH Sensor Specifications ............................................................................... 21
   Temperature Sensor Specifications ................................................................ 21
   Turbidity Sensor Specifications .................................................................... 21
      Total Suspended Solids ............................................................................ 22
   Ammonium Sensor Specifications ................................................................ 22
      Ammonia (Unionized Ammonia and Total Ammonia) .................................. 22
   Chloride Sensor Specifications ..................................................................... 23
   Nitrate Sensor Specifications ....................................................................... 23
   Chlorophyll a Sensor Specifications .............................................................. 23
   BGA-PC Sensor Specifications ..................................................................... 24
   BGA-PE Sensor Specifications ..................................................................... 25
   Rhodamine WT Sensor Specifications .......................................................... 25

4 Instrument Overview ......................................................................................... 27
Synopsis .......................................................................................................................... 27
System Components ......................................................................................................... 28
  Base Unit Components ................................................................................................. 28
  Accessories purchased separately .................................................................................. 28
RuggedCable System ......................................................................................................... 29
  Vented or Non-Vented Cable .......................................................................................... 30
  Jacket Options ............................................................................................................. 30
  Customizable Cable Lengths .......................................................................................... 30
  Cable Termination ........................................................................................................ 30

5 Instrument Setup .......................................................................................................... 32
  Box Contents ................................................................................................................ 32
  Install the Batteries ....................................................................................................... 33
  Desiccant ........................................................................................................................ 33
    Replace the Desiccant .................................................................................................. 34
  Install the Wiper Motor and Sensors ........................................................................... 34
  Removing Sensors ......................................................................................................... 36

6 Connecting to the Sonde .............................................................................................. 37
  Connecting RuggedCable .............................................................................................. 37
    Connect the Instrument to the RuggedCable ............................................................. 37
    Connect TROLL Com Communication Device to the RuggedCable System ............... 37
    Connecting with Bluetooth ......................................................................................... 37
    Connecting to a Wireless TROLL Com ....................................................................... 37
  SDI-12 3 Wire .............................................................................................................. 38
  Modbus Master .............................................................................................................. 40
  Modbus Master with RS232 (Converter Required) ....................................................... 41

7 Modbus PLC Interface Overview .................................................................................. 42
  Setting Up the Instrument ............................................................................................. 42
    Wire the Modbus Master ............................................................................................ 42
    Programming the PLC ................................................................................................ 42
    Reading Parameters .................................................................................................... 43

8 LCD Screen .................................................................................................................... 44
  LCD Screen .................................................................................................................... 44
    Turn on the LCD Screen .......................................................................................... 44
    Status Icons .............................................................................................................. 44
    Additional LCD Icons ............................................................................................. 45
    Full-Text Messages ................................................................................................... 46
  Sonde Menus ................................................................................................................ 46
    Accessing the Sonde Menus ...................................................................................... 46
    Data Log Menu .......................................................................................................... 46
      Start a Log .............................................................................................................. 46
      Stop a Log ............................................................................................................... 47
    Contrast Menu .......................................................................................................... 47
Calibrating Using Concentration ................................................................. 69
Calibrate the Rugged Dissolved Oxygen Sensor (2-Point) ................................ 69
100% Water-saturated Air Calibration ......................................................... 69
0-point Calibration ....................................................................................... 70
Calibrating the Rugged Dissolved Oxygen Sensor Using Concentration .......... 71
RDO Salinity Setting ..................................................................................... 71
Calibrate the Conductivity Sensor ................................................................. 72
Calibrate the Level Sensor ............................................................................ 75
Calibrate the pH Sensor ............................................................................... 75
Calibrate the ORP Sensor ............................................................................ 77
Calibrate the Turbidity Sensor ........................................................................ 79
Calibrate the Ammonium Sensor ................................................................... 82
Calibrate the Chloride Sensor ........................................................................ 84
Calibrate the Nitrate Sensor .......................................................................... 85

17 Win-Situ 5 ..................................................................................................... 87
Verify the Win-Situ Software Version ............................................................ 87
Win-Situ 5 Screens and Buttons ...................................................................... 87
Data Tab ......................................................................................................... 87
Home Tab ....................................................................................................... 89
Logging Tab .................................................................................................... 91
Sensors Tab ..................................................................................................... 92
Device Setup Tab ............................................................................................. 94
Win-Situ 5 Logging and Viewing Data ............................................................ 95
About Sites ....................................................................................................... 95
Logging Data—Overview ............................................................................... 96
Logging Method Descriptions ........................................................................ 96
Logging Methods for Long-Term Monitoring ............................................... 96
  Linear ........................................................................................................... 96
  Linear Average ............................................................................................ 96
  Event ............................................................................................................ 97
Log Setup ......................................................................................................... 97
Starting a Log .................................................................................................. 97
  Starting a Pending Log .................................................................................. 97
  Starting a Manual Log .................................................................................. 97
Suspending (Pausing) a Log ........................................................................... 98
Resuming a Paused Log .................................................................................. 98
Stopping a Log ................................................................................................ 98
Restarting a Log .............................................................................................. 98
Downloading Data to a PC .............................................................................. 98
Viewing Logged Data .................................................................................... 99
Exporting Data ............................................................................................... 99
  Exporting Data to Spreadsheet Format ....................................................... 99
  Exporting to Text .......................................................................................... 100
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphing Data</td>
<td>100</td>
</tr>
<tr>
<td>View a Graph of a Downloaded File</td>
<td>100</td>
</tr>
<tr>
<td>View a Graph of Real-Time Data</td>
<td>100</td>
</tr>
<tr>
<td>Graph Settings</td>
<td>100</td>
</tr>
<tr>
<td>Graph Templates</td>
<td>100</td>
</tr>
<tr>
<td>Graph Tools</td>
<td>100</td>
</tr>
<tr>
<td>Calibration</td>
<td>102</td>
</tr>
<tr>
<td>Calibrate Sensors</td>
<td>102</td>
</tr>
<tr>
<td>Calibrating the Conductivity Sensor</td>
<td>102</td>
</tr>
<tr>
<td>Calibrating the Pressure Sensor</td>
<td>104</td>
</tr>
<tr>
<td>Calibrating the RDO Sensor</td>
<td>105</td>
</tr>
<tr>
<td>Calibrate 100% Oxygen Saturation</td>
<td>106</td>
</tr>
<tr>
<td>Calibrate 0% Oxygen Saturation</td>
<td>107</td>
</tr>
<tr>
<td>Calibrating the pH/ORP Sensor</td>
<td>107</td>
</tr>
<tr>
<td>Calibrating the Turbidity Sensor</td>
<td>108</td>
</tr>
<tr>
<td>Calibrating the Ammonium Sensor</td>
<td>109</td>
</tr>
<tr>
<td>Calibrating the Chloride Sensor</td>
<td>110</td>
</tr>
<tr>
<td>Calibrating the Nitrate Sensor</td>
<td>111</td>
</tr>
<tr>
<td>Calibration Reports</td>
<td>112</td>
</tr>
<tr>
<td>Saving Calibration Reports</td>
<td>112</td>
</tr>
<tr>
<td>Viewing Calibration Reports</td>
<td>112</td>
</tr>
<tr>
<td>BaroMerge</td>
<td>112</td>
</tr>
<tr>
<td>Using BaroMerge Software</td>
<td>112</td>
</tr>
<tr>
<td>Baro Merge Input—Manual Entry</td>
<td>113</td>
</tr>
<tr>
<td>Baro Merge Input—Fixed Correction</td>
<td>114</td>
</tr>
<tr>
<td>BaroMerge Input—BaroTROLL File</td>
<td>115</td>
</tr>
<tr>
<td>BaroMerge Output</td>
<td>116</td>
</tr>
<tr>
<td>Post Level Correction within Baro Merge</td>
<td>116</td>
</tr>
<tr>
<td>Managing Data from Multiple Sites</td>
<td>117</td>
</tr>
<tr>
<td>Adding a Site</td>
<td>117</td>
</tr>
<tr>
<td>Editing a Site</td>
<td>117</td>
</tr>
<tr>
<td>Deleting a Site</td>
<td>117</td>
</tr>
<tr>
<td>Using Site Groups</td>
<td>117</td>
</tr>
<tr>
<td>Creating a Site Group</td>
<td>117</td>
</tr>
<tr>
<td>Site-Based Connections</td>
<td>118</td>
</tr>
<tr>
<td>Creating a Custom Connection</td>
<td>118</td>
</tr>
<tr>
<td>Using a Custom Connection</td>
<td>118</td>
</tr>
<tr>
<td>Storing Custom Connection for a Site</td>
<td>118</td>
</tr>
<tr>
<td>Correcting a Level Reference in Data Files</td>
<td>118</td>
</tr>
<tr>
<td>About Post Correcting Level Data</td>
<td>118</td>
</tr>
<tr>
<td>Open Post Level Correction</td>
<td>119</td>
</tr>
<tr>
<td>Select Level Reference Type</td>
<td>119</td>
</tr>
<tr>
<td>Set the Level Correction</td>
<td>120</td>
</tr>
</tbody>
</table>
18 Water Quality ................................................................. 123
   pH .................................................................................. 123
      What is pH? .................................................................. 123
      Why Measure pH? ....................................................... 124
      The pH/ORP Sensor ................................................... 124
   Oxidation-Reduction Potential ....................................... 125
      What is ORP? ................................................................. 125
      Why Measure ORP? ..................................................... 125
      The pH/ORP Sensor ................................................... 125
   Conductivity ..................................................................... 126
      What is Conductivity? ................................................ 126
      Why Measure Conductivity? ...................................... 126
      How is Conductivity Measured? ............................... 126
   Dissolved Oxygen .......................................................... 127
      What is Dissolved Oxygen? ....................................... 127
      Why Measure DO? ......................................................... 127
      How is DO Measured? ................................................ 128
   Turbidity ......................................................................... 128
      What is Turbidity? ........................................................ 128
      Why Measure Turbidity? ............................................. 128
      How is Turbidity Measured? ................................. 129
19 Care and Maintenance .................................................... 130
   Maintenance Schedule .................................................... 130
   User-Serviceable Parts .................................................. 130
   O-rings .......................................................................... 130
   pH/ORP Sensor Replacement ........................................ 130
   RDO Sensor Cap Replacement ....................................... 130
   Instrument Storage ........................................................... 130
      Short-term Storage (<1 Week) ................................... 130
      Long-term Storage (>1 Week) .................................... 130
   Cleaning the Sonde ......................................................... 131
   Cleaning and Storing the pH/ORP Sensor ....................... 131
      Routine Maintenance .................................................. 131
      Replacing the Filling Solution .................................... 131
      Replacing the Junction ............................................... 132
      Cleaning ................................................................. 132
      Short-term Storage ...................................................... 132
      Long-term Storage ..................................................... 133
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Recommendations</td>
<td>133</td>
</tr>
<tr>
<td>Cleaning and Storing the RDO Sensor</td>
<td>133</td>
</tr>
<tr>
<td>Routine Maintenance</td>
<td>133</td>
</tr>
<tr>
<td>Cleaning the Optical Window</td>
<td>133</td>
</tr>
<tr>
<td>Storage</td>
<td>133</td>
</tr>
<tr>
<td>Cleaning and Storing the Conductivity Sensor</td>
<td>134</td>
</tr>
<tr>
<td>Cleaning</td>
<td>134</td>
</tr>
<tr>
<td>Storage</td>
<td>134</td>
</tr>
<tr>
<td>Cleaning and Storing the Turbidity Sensor</td>
<td>134</td>
</tr>
<tr>
<td>Routine Maintenance</td>
<td>134</td>
</tr>
<tr>
<td>Storage</td>
<td>134</td>
</tr>
<tr>
<td>Replacing Wiper Bristles</td>
<td>135</td>
</tr>
<tr>
<td>Replace the Bristles</td>
<td>135</td>
</tr>
<tr>
<td>Replace the Entire Brush</td>
<td>135</td>
</tr>
<tr>
<td>Cleaning the Copper Antifouling Restrictor</td>
<td>135</td>
</tr>
<tr>
<td><strong>20 Declaration of Conformity</strong></td>
<td>136</td>
</tr>
<tr>
<td><strong>21 Appendix</strong></td>
<td>137</td>
</tr>
<tr>
<td>Appendix A: Parameter Discovery</td>
<td>137</td>
</tr>
<tr>
<td>Appendix B: Parameter Numbers and Locations</td>
<td>137</td>
</tr>
<tr>
<td>Appendix C: Unit Ids</td>
<td>138</td>
</tr>
<tr>
<td>Appendix D: Register Data Formats</td>
<td>141</td>
</tr>
</tbody>
</table>
Introduction

This manual is intended to describe the characteristics, operation, calibration, and maintenance of the AquaTROLL 600 Multiparameter Sonde.

Serial Number Location

The instrument serial number is on the product label affixed to the instrument body. Serial numbers for individual sensors are engraved on the sensor body.

Instrument Description

The Aqua TROLL 600 Sonde is a multiparameter water quality sonde with LCD screen, internal memory, and additional SD card storage. The Aqua TROLL 600 uses the latest sensor and electronics technology to provide laboratory-quality measurements for field use. The water level/pressure sensor and barometric pressure sensor are integrated into the sonde. The optical Rugged Dissolved Oxygen (RDO®), conductivity, temperature, turbidity, pH/ORP sensors and the RDO Sensor Cap are replaceable. It is optional to include a motorized sensor wiper on the instrument.

The Aqua TROLL 600 can connect wirelessly via Bluetooth to the VuSitu Mobile App or can connect to Win-Situ 5 Software using cable or Bluetooth.

Document Conventions

Throughout this document you will see the following symbols:

- A check mark highlights a tip or feature.
- The exclamation point calls your attention to a requirement, safety issue, or important action that should not be overlooked.

Unpacking and Inspection

Your equipment was carefully inspected before shipping. Check the equipment for any physical damage sustained during shipment. Notify In-Situ and file a claim with the carrier if there is any such damage; do not attempt to deploy or operate the instrument.

- Save packing materials for future storage and shipping of your equipment.

Accessories may be shipped separately and should also be inspected for physical damage and fulfillment of your order.

Obtaining Repair Service

If you suspect your system is malfunctioning and repair is needed, you can help assure efficient servicing by following these guidelines:

1. Call or email In-Situ Technical Support. Have the product model and serial number available.
2. Be prepared to describe the problem, including how the product was used and the conditions noted at the time of the malfunction.
3. If Technical Support determines that service is needed, they will ask your company to fill out the RMA form and pre-approve a specified monetary amount for repair charges. When the form and pre-approval is received, Technical Support will assign an RMA (Return Material Authorization) number.

4. Clean the product as described in the manual.

5. If the product contains a removable battery, remove and retain it unless you are returning the system for a refund or Technical Support states otherwise.

6. Carefully pack your product in its original shipping box, if possible.

7. Mark the RMA number clearly on the outside of the box.

8. Send the package, shipping prepaid, to:

   In-Situ
   ATTN: Repairs
   221 East Lincoln Avenue
   Fort Collins, CO 80524

   The warranty does not cover damage during transit. In-Situ recommends insurance for all shipments. Warranty repairs will be shipped back prepaid.

**Outside the U.S.**

   Contact your international In-Situ distributor for repair and service information.

### Guidelines for Cleaning Returned Equipment

Please help us protect the health and safety of our employees by cleaning and decontaminating equipment that has been subjected to potential biological or health hazards, and labeling such equipment. Unfortunately, we cannot service your equipment without such notification. Please complete and sign the form on page 12 (or a similar statement certifying that the equipment has been cleaned and decontaminated) and send it to us with each instrument.

- We recommend the glassware cleaning product, Alconox, available from In-Situ and from laboratory supply companies.
- Clean all cables and remove all foreign matter.
- Clean the cable connectors with a clean, dry cloth. Do not submerge the connectors.
- Clean the instrument including the nosecone, cable head, and protective caps.

If an instrument is returned to our Service Center for repair or recalibration without a statement that it has been cleaned and decontaminated, or if it is the opinion of our Service Representatives that the equipment presents a potential health or biological hazard, we reserve the right to withhold service until proper certification is obtained.
Decontamination and Cleaning Form

Decontamination & Cleaning Statement

Company Name __________________________ Phone __________________________
Address __________________________
City __________________________ State __________________________ Zip
Instrument Type __________________________ Serial Number __________________________
Contaminant(s) (if known) __________________________
Decontamination procedure(s) used __________________________
Cleaning verified by __________________________ Title __________________________
Date __________________________

In-Situ Inc.

Safety

- Use D-cell alkaline batteries.
- Do not use batteries of different ages or types.
- Do not submerge the Wireless TROLL Com or your mobile device in liquid.
- Ensure that sensors, or sensor plugs, are completely inserted into the ports, so that no liquid can enter the instrument.
- Ensure that the RDO Sensor Cap is pressed firmly over the sensor lens and is flush with the instrument before submerging in liquid.
- Replace the cable if insulation or connectors are damaged.
- Make sure the probe and sensor O-rings are clean and free of damage.
### General Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating temperature</strong></td>
<td>-5 to 50° C (23 to 122° F)</td>
</tr>
<tr>
<td><strong>Storage temperature</strong></td>
<td>Components without fluid: -40 to 65° C (-40 to 149° F) pH/ORP probes: -5 to 65° C</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>4.7 cm (1.85 in.) OD x 60.2 cm (23.7 in.) with restrictor installed (including connector) With bail: 73.9 cm (29.1 in.)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>1.45 kg (3.2 lbs) - includes all sensors, batteries, bail</td>
</tr>
<tr>
<td><strong>Wetted materials (sonde and sensors)</strong></td>
<td>Ceramic, Delrin™, Inconel™, PC, PC alloy, Platinum, Nylon, Santoprene™, Titanium, Viton™</td>
</tr>
<tr>
<td><strong>Environmental rating</strong></td>
<td>IP68 with all sensors and cable attached. IP67 with sensors removed, battery cover removed, or cable detached</td>
</tr>
<tr>
<td><strong>Max pressure rating</strong></td>
<td>Up to 350 PSI</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td>RS485/MODBUS, SDI-12, Bluetooth®</td>
</tr>
<tr>
<td><strong>Reading rate</strong></td>
<td>1 reading every 2 seconds for one parameter, no wipe</td>
</tr>
<tr>
<td><strong>Internal memory</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td>16 MB</td>
</tr>
<tr>
<td><strong>Additional memory, micro SD card</strong>&lt;sup&gt;2&lt;/sup&gt;</td>
<td>16+ GB included, any size micro SD up to 32 GB accepted</td>
</tr>
<tr>
<td><strong>Logging rate</strong></td>
<td>1 minute to 99 hours</td>
</tr>
<tr>
<td><strong>Logging modes</strong></td>
<td>Linear, Linear Average, Event</td>
</tr>
<tr>
<td><strong>Data logging</strong></td>
<td>50 logs (defined, scheduled to run, or stored)</td>
</tr>
<tr>
<td><strong>LCD screen</strong></td>
<td>Integrated display shows status of sonde, sensor ports, data log, battery, and connectivity</td>
</tr>
<tr>
<td><strong>Internal power Battery life</strong>&lt;sup&gt;3&lt;/sup&gt;</td>
<td>(2) user-replaceable D-cell alkaline batteries &gt;6 months typical with wiping &gt;9 months typical without wiping</td>
</tr>
<tr>
<td><strong>External power voltage</strong>&lt;sup&gt;4&lt;/sup&gt;</td>
<td>8-36 VDC, 275 mA maximum (not required)</td>
</tr>
<tr>
<td><strong>External power current</strong>&lt;sup&gt;4&lt;/sup&gt;</td>
<td>Sleep: 0.10 mA typical Measurement: 15 mA typical, 45 mA maximum</td>
</tr>
<tr>
<td>Interface</td>
<td>Win-Situ 5 Software, VuSitu Mobile App on select mobile devices using Android 4.4 with Bluetooth 2.0</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cable</td>
<td>Vented or non-vented polyurethane or vented Tefzel®</td>
</tr>
<tr>
<td>Hex screw driver</td>
<td>0.050 in. (1.3 mm)</td>
</tr>
<tr>
<td>Software Interface</td>
<td>Android: VuSitu available on the Google Play Store (Android 4.4 or above, requires Bluetooth 2.0)</td>
</tr>
<tr>
<td></td>
<td>Windows: Win-Situ 5</td>
</tr>
<tr>
<td></td>
<td>Data Services: HydroVu</td>
</tr>
<tr>
<td>Certifications</td>
<td>CE, FCC, WEEE, RoHS compliant</td>
</tr>
<tr>
<td>Warranty</td>
<td>2 year - sonde, sensors (excluding pH/ORP);</td>
</tr>
<tr>
<td></td>
<td>1 year - pH/ORP sensor</td>
</tr>
<tr>
<td></td>
<td>Other - see warranty policy at <a href="http://www.in-situ.com">www.in-situ.com</a></td>
</tr>
</tbody>
</table>

Notes

Specifications are subject to change without notice. Android is a trademark of Google, Inc. Bluetooth is a trademark of Bluetooth SIG, Inc. Delrin and Tefzel are trademarks of E.I. du Pont de Nemours & Co. Santoprene is a trademark of ExxonMobile. Inconel is a trademark of Special Metals Corporation. Viton is a registered trademark of DuPont Performance Elastomers L.L.C.

1For 30 parameters>100,000 data records, > 3 years at 15 minute interval. A single data record includes timestamp, temperature, RDO, pH, ORP, turbidity, and conductivity logged in Linear or Linear Average mode.

2Log data recorded to SD card in comma delimited variable (CSV) file format.

3Logging all sensors at 15 minute interval on 2 D-cell alkaline batteries. Battery life dependent on site conditions and wiping.

4Dependent on display and wiping.
**Instrument Dimensions with Restrictor On**

<table>
<thead>
<tr>
<th>Total length with connector</th>
<th>60.2 cm (23.7 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diameter</td>
<td>47 mm (1.85 in.)</td>
</tr>
</tbody>
</table>

**Instrument Dimensions with Restrictor Off**

| Total length with wiper brush on | 56.2 cm (22.12 in.) |
| Total length with wiper brush off | 52.6 cm (20.7 in.) |
| Diameter                         | 41.66 mm (1.64 in.) |

**Sensor Specifications**

**Sensor Summary**

<table>
<thead>
<tr>
<th>Sensors</th>
<th>Product Life*</th>
<th>Recommended Calibration Frequency**</th>
<th>Pressure Rating - PSI</th>
<th>Usable Depth</th>
<th>Operational Temperature Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>pH/ORP</td>
<td>15 months</td>
<td>10 to 12 weeks</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>RDO</td>
<td>2 years or greater</td>
<td>12 months</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>Conductivity</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>Temperature</td>
<td>2 years or greater</td>
<td>NA</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>Parameter</td>
<td>Frequency</td>
<td>Measurement Range</td>
<td>Temperature Range</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turbidity</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>Pressure</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>12.8</td>
<td>9</td>
<td>30</td>
</tr>
<tr>
<td>Barometric Pressure</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Ammonium</td>
<td>6 to 12 months</td>
<td>Monthly</td>
<td>30</td>
<td>25</td>
<td>70</td>
</tr>
<tr>
<td>Chloride</td>
<td>1 year or greater</td>
<td>Monthly</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>Nitrate</td>
<td>6 to 12 months</td>
<td>Monthly</td>
<td>30</td>
<td>25</td>
<td>70</td>
</tr>
<tr>
<td>Chlorophyll a</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>BGA-PC</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>BGA-PE</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
<tr>
<td>Rhodamine</td>
<td>2 years or greater</td>
<td>User calibration only if needed</td>
<td>350</td>
<td>200</td>
<td>650</td>
</tr>
</tbody>
</table>

* Product life and calibration frequency dependent on site conditions.

** pH/ORP sensor life is 12 months in deployment conditions.

**Potential Interferents**

**pH**
Sodium salts

**Dissolved Oxygen**
Temperature, atmospheric pressure, salinity, chlorinity

**Ammonium**
Cesium, Potassium, Thallium, pH, Silver, Lithium, Sodium

**Nitrate**
Perchlorate, Iodide, Chlorate, Cyanide, Bromide, Nitrite, Hydrogen Sulfide (bisulfite), Hydrogen Carbonate (bicarbonate), Carbonate, Chloride, Dihydrogen Phosphate, Hydrogen Phosphate, Phosphate, Acetate, Fluoride, Sulfate

**Conductivity**
Temperature

**ORP**
Ions that are stronger reducing agents than hydrogen or platinum, e.g., chromium, vanadium, titanium, etc.

**Chloride**
Hydroxide, Ammonia, Thiosulfate, Bromide, Sulfide, Iodide, Cyanide

**BGA-PC, BGA-PE, Chlorophyll a, Rhodamine**
Turbidity
RDO Cap Chemical Incompatibility

The following chemicals will damage the RDO sensing element.

- Alcohols > 5%
- Hydrogen peroxide > 3%
- Sodium hypochlorite (commercial bleach) > 3%
- Gaseous sulfur dioxide
- Gaseous chlorine
- Do not use in organic solvents (e.g., acetone, chloroform, methylene chloride, etc.), which may destroy the sensing element

Ammonium, Chloride and Nitrate Interferent Concentrations

Ammonium

The table below lists concentrations of possible interfering ions that cause 10% error at various levels (in ppm) of NH₄⁺.

<table>
<thead>
<tr>
<th>Ion</th>
<th>100 ppm NH₄⁺</th>
<th>10 ppm NH₄⁺</th>
<th>1 ppm NH₄⁺</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cesium (Cs⁺)</td>
<td>100</td>
<td>10</td>
<td>1</td>
</tr>
<tr>
<td>Potassium (K⁺)</td>
<td>270</td>
<td>27</td>
<td>2.7</td>
</tr>
<tr>
<td>Thallium (Tl⁺)</td>
<td>3100</td>
<td>310</td>
<td>31</td>
</tr>
<tr>
<td>pH (H⁺)</td>
<td>pH 1.6</td>
<td>pH 2.6</td>
<td>pH 3.6</td>
</tr>
<tr>
<td>Silver (Ag⁺)</td>
<td>270,000</td>
<td>27,000</td>
<td>2,700</td>
</tr>
<tr>
<td>Lithium (Li⁺)</td>
<td>35,000</td>
<td>3,500</td>
<td>350</td>
</tr>
<tr>
<td>Sodium (Na⁺)</td>
<td>11,100</td>
<td>1,100</td>
<td>110</td>
</tr>
</tbody>
</table>

Chloride

The table below lists concentrations of possible interfering ions that cause 10% error at various levels (in ppm) of Cl⁻.

<table>
<thead>
<tr>
<th>Ion</th>
<th>100 ppm Cl⁻</th>
<th>10 ppm Cl⁻</th>
<th>1 ppm Cl⁻</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydroxide (OH⁻)</td>
<td>3,840</td>
<td>384</td>
<td>38.4</td>
</tr>
<tr>
<td>Ammonia (NH₃)</td>
<td>6</td>
<td>0.6</td>
<td>0.06</td>
</tr>
<tr>
<td>Thiosulfate (S₂O₃²⁻)</td>
<td>3</td>
<td>0.3</td>
<td>0.03</td>
</tr>
<tr>
<td>Bromide (Br⁻)</td>
<td>0.68</td>
<td>0.069</td>
<td>6.8 x 10⁻³</td>
</tr>
<tr>
<td>Sulfide (S²⁻)</td>
<td>9 x 10⁻⁵</td>
<td>9 x 10⁻⁶</td>
<td>9 x 10⁻⁷</td>
</tr>
<tr>
<td>Iodide (I⁻)</td>
<td>1.8 x 10⁻⁴</td>
<td>1.8 x 10⁻⁵</td>
<td>1.8 x 10⁻⁶</td>
</tr>
<tr>
<td>Cyanide (CN⁻)</td>
<td>1.5 x 10⁻⁵</td>
<td>1.5 x 10⁻⁶</td>
<td>1.5 x 10⁻⁷</td>
</tr>
</tbody>
</table>

Nitrate

The table below lists concentrations of possible interfering ions that cause 10% error at various levels (in ppm) of NO₃⁻.

<table>
<thead>
<tr>
<th>Ion</th>
<th>100 ppm NO₃⁻ as N</th>
<th>10 ppm NO₃⁻ as N</th>
<th>1 ppm NO₃⁻ as N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perchlorate (ClO₄⁻)</td>
<td>7 x 10⁻²</td>
<td>7 x 10⁻³</td>
<td>7 x 10⁻⁴</td>
</tr>
<tr>
<td>Iodide (I⁻)</td>
<td>4</td>
<td>0.4</td>
<td>0.04</td>
</tr>
<tr>
<td>Chlorate (ClO₃⁻)</td>
<td>30</td>
<td>3</td>
<td>0.3</td>
</tr>
<tr>
<td>Cyanide (CN⁻)</td>
<td>20</td>
<td>2</td>
<td>0.2</td>
</tr>
<tr>
<td>Ion</td>
<td>Concentration (ppb)</td>
<td>ppm</td>
<td>µM</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Bromide (Br⁻)</td>
<td>400</td>
<td>40</td>
<td>4</td>
</tr>
<tr>
<td>Nitrite (NO₂⁻)</td>
<td>230</td>
<td>23</td>
<td>2</td>
</tr>
<tr>
<td>Hydrogen Sulfide (HS⁻)</td>
<td>230</td>
<td>23</td>
<td>2</td>
</tr>
<tr>
<td>Bicarbonate (HCO₃⁻)</td>
<td>440</td>
<td>440</td>
<td>44</td>
</tr>
<tr>
<td>Carbonate (CO₃²⁻)</td>
<td>8,600</td>
<td>860</td>
<td>86</td>
</tr>
<tr>
<td>Chloride (Cl⁻)</td>
<td>7,600</td>
<td>760</td>
<td>76</td>
</tr>
<tr>
<td>Dihydrogen Phosphate (H₂PO₄⁻)</td>
<td>34,640</td>
<td>3,464</td>
<td>346</td>
</tr>
<tr>
<td>Hydrogen Phosphate (HPO₄²⁻)</td>
<td>34,300</td>
<td>3,430</td>
<td>343</td>
</tr>
<tr>
<td>Phosphate (PO₄³⁻)</td>
<td>33,900</td>
<td>3,390</td>
<td>339</td>
</tr>
<tr>
<td>Acetate (OAc⁻)</td>
<td>104,200</td>
<td>10,420</td>
<td>1,042</td>
</tr>
<tr>
<td>Fluoride (F⁻)</td>
<td>81,400</td>
<td>8,140</td>
<td>814</td>
</tr>
<tr>
<td>Sulfate (SO₄²⁻)</td>
<td>685,700</td>
<td>68,570</td>
<td>6,857</td>
</tr>
</tbody>
</table>

**Barometric Pressure Sensor Specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accuracy</td>
<td>±1.0 mbar</td>
</tr>
<tr>
<td>Range</td>
<td>300 to 1,100 mbar</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.1 mbar</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Fixed</td>
</tr>
<tr>
<td>Response Time</td>
<td>T63&lt;1s, T90&lt;1s, T95&lt;1s</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>psi, kPa, bar, mbar, mmHg, inHg</td>
</tr>
<tr>
<td>Methodology</td>
<td>Silicon strain gauge</td>
</tr>
</tbody>
</table>

**Conductivity Sensor Specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accuracy*</td>
<td>±0.5% of reading plus 1 µS/cm from 0 to 100,000 µS/cm; ±1.0% of reading from 100,000 to 200,000 µS/cm; ±2% of reading from 200,000 to 350,000 µS/cm</td>
</tr>
<tr>
<td>Range</td>
<td>0 to 350,000 µS/cm</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.1 µS/cm</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Removeable</td>
</tr>
<tr>
<td>Response Time</td>
<td>T63&lt;1s, T90&lt;3s, T95&lt;5s</td>
</tr>
</tbody>
</table>
| Units of Measure          | Actual conductivity: μS/cm, mS/cm  
|                         | Specific conductivity: μS/cm, mS/cm  
|                         | Salinity: PSU  
|                         | Total dissolved solids: ppt, ppm  
|                         | Resistivity: Ohms-cm  
|                         | Density: g/cm³  
| Methodology             | Std. Methods 2510, EPA 120.1  

*Accuracy at calibration points. For greatest accuracy over instrument life, keep the conductivity cell submersed in water for 24-48 hours prior to calibration and deployment.

**Total Dissolved Solids**

TDS is derived from conductivity and temperature.

| Range                        | 0 to 350 ppt  
| Resolution                   | 0.1 ppt  
| Units of Measure             | ppt, ppm  

**Salinity**

TDS is derived from conductivity and temperature.

| Range                        | 0 to 350 PSU  
| Resolution                   | 0.1 PSU  
| Units of Measure             | PSU, ppt  
| Methodology                  | Std. Methods 2520A  

**Dissolved Oxygen RDO Sensor Specifications**

| Accuracy                     | ±0.1 mg/L from 0 to 20 mg/L  
|                              | ±2% of reading from 20 to 60 mg/L  
| Range                        | 0 to 60 mg/L  
| Resolution                   | 0.01 mg/L  
| Sensor Type                  | Removable with replaceable RDO-X Cap  
| Response Time                | RDO-X Cap: T63<15s, T90<45s, T95<60s  
|                              | RDO Fast Cap: T63<3 sec, T90<30 sec, T95<45 sec  

### Units of Measure

| Units of Measure | \( \text{mg/L, } \% \text{ saturation, ppm} \) |

### Methodology

EPA-approved In-Situ Methods (under the Alternate Test Procedure process): 1002-8-2009, 1003-8-2009, 1004-8-2009

### Level, Depth, Pressure Sensor Specifications

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>Typical ±0.1% full scale (FS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>Non-vented or Vented</td>
</tr>
<tr>
<td></td>
<td>9.0 m (30 ft) - Burst: 27 m (90 ft)</td>
</tr>
<tr>
<td></td>
<td>30 m (100 ft) - Burst: 40 m (130 ft)</td>
</tr>
<tr>
<td></td>
<td>76 m (250 ft) - Burst: 107 m (350 ft)</td>
</tr>
<tr>
<td></td>
<td>200 m (650 ft) - Burst: 229 m (750 ft)</td>
</tr>
<tr>
<td>Resolution</td>
<td>±0.01% FS or better</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Fixed</td>
</tr>
<tr>
<td>Response Time</td>
<td>T63&lt;1s, T90&lt;1s, T95&lt;1s</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH(_2)O, inH(_2)O</td>
</tr>
<tr>
<td></td>
<td>Level: mm, cm, m, in, ft, cmH(_2)O, inH(_2)O</td>
</tr>
<tr>
<td>Methodology</td>
<td>Piezoresistive; ceramic</td>
</tr>
</tbody>
</table>

*Typical performance across full temperature and pressure calibrated range. Typical is defined as all values within 1 standard deviation.

### ORP Sensor Specifications

| Accuracy* | ±5.0 mV @ 25° C |
| Range     | ±1,400 mV       |
| Resolution| 0.1 mV          |
| Sensor Type| Replaceable pH/ORP combo sensor |
| Response Time** | T63<3s, T90<15s, T95<30s |
| Units of Measure | mV |
| Methodology | Std. Methods 2580 |

*Accuracy from standard at 25° C.

**At thermal equilibrium immediately following calibration, measuring from air to +400 mV
### pH Sensor Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accuracy</strong></td>
<td>±0.1 pH units or better</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>0 to 14 pH units</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>0.01 pH unit</td>
</tr>
<tr>
<td><strong>Sensor Type</strong></td>
<td>Replaceable pH/ORP combo sensor</td>
</tr>
<tr>
<td><strong>Response Time</strong></td>
<td>T63&lt;1s, T90&lt;2s, T95&lt;3s</td>
</tr>
<tr>
<td><strong>Units of Measure</strong></td>
<td>pH units</td>
</tr>
<tr>
<td><strong>Methodology</strong></td>
<td>Std. Methods 4500-H+, EPA 150.2</td>
</tr>
</tbody>
</table>

*At thermal equilibrium.

### Temperature Sensor Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accuracy</strong></td>
<td>±0.1°C</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>-5 to 50°C (23 to 122°F)</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>0.01°C</td>
</tr>
<tr>
<td><strong>Sensor Type</strong></td>
<td>Replaceable</td>
</tr>
<tr>
<td><strong>Response Time</strong></td>
<td>T63&lt;2s, T90&lt;15s, T95&lt;30s</td>
</tr>
<tr>
<td><strong>Units of Measure</strong></td>
<td>°C, °F</td>
</tr>
<tr>
<td><strong>Methodology</strong></td>
<td>EPA 170.1</td>
</tr>
</tbody>
</table>

*Typical system response with instrument, sensors, and restrictor when changing approximately 15°C in moderate flow.*

### Turbidity Sensor Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accuracy</strong></td>
<td>±2% of reading or ±0.5 NTU or FNU, whichever is greater</td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>0 to 4,000 NTU</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>0.01 NTU (0 to 1,000 NTU)</td>
</tr>
<tr>
<td></td>
<td>0.1 NTU (1,000 to 4,000 NTU)</td>
</tr>
<tr>
<td><strong>Sensor Type</strong></td>
<td>Replaceable</td>
</tr>
<tr>
<td><strong>Response Time</strong></td>
<td>T63&lt;1s, T90&lt;1s, T95&lt;1s</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>NTU, FNU</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------</td>
</tr>
<tr>
<td>Methodology</td>
<td>ISO 7027</td>
</tr>
</tbody>
</table>

**Total Suspended Solids**

TSS is derived from turbidity.

<table>
<thead>
<tr>
<th>Range</th>
<th>0 to 1,500 mg/L</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>0.1 mg/L</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>ppt, mg/L</td>
</tr>
</tbody>
</table>

User-defined reference.

**Ammonium Sensor Specifications**

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>±10% or ±2 mg/L, w.i.g.*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Depth</td>
<td>25 m, 30 PSI</td>
</tr>
<tr>
<td>Range</td>
<td>0-10,000 mg/L as N</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.01 mg/L</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Removable</td>
</tr>
<tr>
<td>Response Time*</td>
<td>T90 &lt; 10sec, T95 &lt; 30sec</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>mg/L, ppm, mV</td>
</tr>
<tr>
<td>Methodology</td>
<td>Std. Methods 4500-NH₃D, EPA 350.3</td>
</tr>
</tbody>
</table>

*Between calibration points.

**Ammonia (Unionized Ammonia and Total Ammonia)**

Ammonia is derived from ammonium, pH and salinity. pH sensor and conductivity/temperature sensor required.

<table>
<thead>
<tr>
<th>Range</th>
<th>0 to 10,000 mg/L</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>0.01 mg/L</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>mg/L, ppm</td>
</tr>
</tbody>
</table>
### Chloride Sensor Specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accuracy</td>
<td>±10% or ±2 mg/L, w.i.g.*</td>
</tr>
<tr>
<td>Range</td>
<td>0-190,000 mg/L - CL*</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.01 mg/L</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Removable</td>
</tr>
<tr>
<td>Response Time*</td>
<td>T90 &lt; 10sec, T95 &lt; 30sec</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>mg/L, ppm, mV</td>
</tr>
<tr>
<td>Methodology</td>
<td>Std. Methods 4500-Cl(^{\text{D}})</td>
</tr>
</tbody>
</table>

*Between calibration points.

### Nitrate Sensor Specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accuracy</td>
<td>±10% or ±2 mg/L, w.i.g.*</td>
</tr>
<tr>
<td>Max Depth</td>
<td>25 m, 30 PSI</td>
</tr>
<tr>
<td>Range</td>
<td>0-50,000 mg/L as N</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.01 mg/L</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Removable</td>
</tr>
<tr>
<td>Response Time*</td>
<td>T90 &lt; 10sec, T95 &lt; 30sec</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>mg/L, ppm, mV</td>
</tr>
<tr>
<td>Methodology</td>
<td>Std. Methods 4500-NO(^{3})(^{\text{D}})</td>
</tr>
</tbody>
</table>

*Between calibration points.

### Chlorophyll a Sensor Specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linearity</td>
<td>(R^2 &gt; 0.999) for serial dilutions of 0-1000 µg/L Chl a in MeOH</td>
</tr>
<tr>
<td>Max Depth</td>
<td>200 m</td>
</tr>
<tr>
<td>Range</td>
<td>0-100 RFU</td>
</tr>
<tr>
<td></td>
<td>0-1000 µg/L Chl a in MeOH</td>
</tr>
</tbody>
</table>
| Resolution          | .001 RFU  
<table>
<thead>
<tr>
<th></th>
<th>.01 µg/L Chl a</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Type</td>
<td>Removable</td>
</tr>
<tr>
<td>Response Time*</td>
<td>T63&lt;1s, T90&lt;1s, T95&lt;1s</td>
</tr>
</tbody>
</table>
| Units of Measure    | Concentration: µg/L  
|                     | Fluorescence: RFU |
| Excitation Wavelength (nominal) | 430 nm |
| Detection Wavelength | 675 nm to 750 nm |

**BGA-PC Sensor Specifications**

<table>
<thead>
<tr>
<th>Linearity</th>
<th>$R^2 &gt; 0.999$ for serial dilutions of PC standards from 0-1000 µg/L PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Depth</td>
<td>200 m</td>
</tr>
</tbody>
</table>
| Range                | 0-100 RFU  
|                      | 0-1000 µg/L PC                                                       |
| Resolution           | .001 RFU  
|                      | .01 µg/L PC                                                          |
| Sensor Type          | Removable                                                            |
| Response Time*       | T63<1s, T90<1s, T95<1s                                              |
| Units of Measure     | Concentration: µg/L  
|                      | Fluorescence: RFU                                                    |
| Excitation Wavelength (nominal) | 590 nm |
| Detection Wavelength | 640 nm to 690 nm                                                    |
### BGA-PE Sensor Specifications

<table>
<thead>
<tr>
<th>Linearity</th>
<th>$R^2 &gt; 0.999$ for serial dilutions of PE standards from 0-1000 µg/L PE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Depth</td>
<td>200 m</td>
</tr>
<tr>
<td>Range</td>
<td>0-100 RFU</td>
</tr>
<tr>
<td></td>
<td>0-1000 µg/L PE</td>
</tr>
<tr>
<td>Resolution</td>
<td>.001 RFU</td>
</tr>
<tr>
<td></td>
<td>.01 µg/L PE</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Removable</td>
</tr>
<tr>
<td>Response Time*</td>
<td>T63&lt;1s, T90&lt;1s, T95&lt;1s</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>Concentration: µg/L</td>
</tr>
<tr>
<td></td>
<td>Fluorescence: RFU</td>
</tr>
<tr>
<td>Excitation Wavelength</td>
<td>498 nm</td>
</tr>
<tr>
<td>(nominal)</td>
<td></td>
</tr>
<tr>
<td>Detection Wavelength</td>
<td>575 nm to 625 nm</td>
</tr>
</tbody>
</table>

### Rhodamine WT Sensor Specifications

<table>
<thead>
<tr>
<th>Linearity</th>
<th>$R^2 &gt; 0.999$ for serial dilutions of RWT (Rhodamine Water Tracer) standards from 0-1000 µg/L</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Depth</td>
<td>200 m</td>
</tr>
<tr>
<td>Range</td>
<td>0-100 RFU</td>
</tr>
<tr>
<td></td>
<td>0-1000 µg/L PE</td>
</tr>
<tr>
<td>Resolution</td>
<td>.001 RFU</td>
</tr>
<tr>
<td></td>
<td>.01 µg/L PE</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Removable</td>
</tr>
<tr>
<td>Response Time*</td>
<td>T63&lt;1s, T90&lt;1s, T95&lt;1s</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>Concentration: µg/L</td>
</tr>
<tr>
<td></td>
<td>Fluorescence: RFU</td>
</tr>
<tr>
<td>Excitation Wavelength (nominal)</td>
<td>530 nm</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Detection Wavelength</td>
<td>580 nm to 660 nm</td>
</tr>
</tbody>
</table>
Instrument Overview

Synopsis

The Aqua TROLL® 600 is a portable, intelligent water quality data logging instrument built to measure and store water level (pressure), temperature, barometric pressure, and water quality data for many applications under many environmental conditions, including marine waters. The instrument’s outside diameter (OD) allows the instrument to conform to a 2-in./5.08 cm diameter (or larger) well. The Aqua TROLL 600 is recommended for applications like ambient long-term water quality monitoring in fresh and marine environments; groundwater quality sampling (e.g., low-flow groundwater sampling, groundwater quality monitoring); mine water monitoring; stormwater management; vertical profiling; horizontal transect; and other environmental applications in normal and extreme environmental conditions. The housing and sensing materials allow it to be used in various environments from fresh water to saltwater. The instrument’s LCD screen provides clear, instant visual indicators of overall readiness, battery life, internal log, sensor status, and connectivity. It is easily programmed through the VuSitu™ Mobile Application available for Android™ devices (Android 4.4, requires Bluetooth® 2.0) or Win-Situ® 5 for Windows®. Users can email data from an Android device via the VuSitu Mobile App; log data to a smartphone; or download data directly to a computer via smartphone connection; tag sites with GPS coordinates; and keep track of sites with photos and descriptions. Data can also be downloaded via an internal, removable micro SD card. Calibrations are simplified through auto-detection of calibration solutions and auto-stabilization. The instrument can be deployed using In-Situ’s RuggedCable System, and with In-Situ’s Tube/Cube Telemetry Systems and HydroVu™ Data Services for real-time data access anywhere there is an internet connection.
# System Components

## Base Unit Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDO Sensor - includes RDO-X Cap</td>
<td>0063450</td>
</tr>
<tr>
<td>Combination pH/ORP Sensor</td>
<td>0063470</td>
</tr>
<tr>
<td>Turbidity Sensor</td>
<td>0063480</td>
</tr>
<tr>
<td>Combination Conductivity/Temperature Sensor or standalone Temperature Sensor</td>
<td>0063460, 0063490</td>
</tr>
<tr>
<td>Alkaline Batteries (2)</td>
<td>0042020</td>
</tr>
<tr>
<td>Dual Stainless Steel Restrictor/Storage Chamber</td>
<td>0079820</td>
</tr>
<tr>
<td>Sensor Port Plugs (2)</td>
<td>0063510</td>
</tr>
<tr>
<td>Rubber Bumpers (2)</td>
<td>0079880</td>
</tr>
<tr>
<td>Wiper or Wiper Port Plug</td>
<td>0063500, 0064630</td>
</tr>
</tbody>
</table>

**Accessories purchased separately.**

<table>
<thead>
<tr>
<th>Communications</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless TROLL Com for Android</td>
<td>0031240</td>
</tr>
<tr>
<td>Mobile Device for Android</td>
<td>0064860</td>
</tr>
<tr>
<td>TROLL Com RS-232 Cable Connect</td>
<td>0056140</td>
</tr>
<tr>
<td>TROLL Com USB Cable Connect</td>
<td>0052500</td>
</tr>
<tr>
<td>TROLL Com RS-232 Direct Connect</td>
<td>0056150</td>
</tr>
<tr>
<td>TROLL Com USB Direct Connect</td>
<td>0052510</td>
</tr>
<tr>
<td>Stripped-and-tinned Cable with male connector</td>
<td>0053310</td>
</tr>
<tr>
<td>Twist-Lock Bulkhead Connector</td>
<td>0053240</td>
</tr>
<tr>
<td>Twist-Lock Backshell / Hanger, Titanium</td>
<td>0051480</td>
</tr>
<tr>
<td>Cable Extender</td>
<td>0051490</td>
</tr>
<tr>
<td>Large Desiccant (titanium connector)</td>
<td>0051810</td>
</tr>
<tr>
<td>Large Desiccant (ABS connector)</td>
<td>0053550</td>
</tr>
<tr>
<td>Small Desiccant (3 pack) - storage desiccant</td>
<td>0052230</td>
</tr>
<tr>
<td>Desiccant Refill Kit for Large or Outboard Desiccant</td>
<td>0029140</td>
</tr>
</tbody>
</table>
## Calibration and Maintenance

<table>
<thead>
<tr>
<th>Item</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDO Classic Cap Replacement Kit</td>
<td>0079790</td>
</tr>
<tr>
<td>pH/ORP Replacement Reference Junction Kit</td>
<td>0078990</td>
</tr>
<tr>
<td>Wiper Brush Kit</td>
<td>0079810</td>
</tr>
<tr>
<td>Maintenance Kit</td>
<td>0078940</td>
</tr>
<tr>
<td>Copper Antifouling Guard</td>
<td>0076100</td>
</tr>
<tr>
<td>Quick-Cal Solution for calibrating DO, Cond., pH &amp; ORP</td>
<td>0033250</td>
</tr>
<tr>
<td>Dissolved Oxygen Calibration Kit</td>
<td>0032110</td>
</tr>
<tr>
<td>D.O. Field Calibration Kit</td>
<td>0080830</td>
</tr>
<tr>
<td>Conductivity Calibration Kit (Full)</td>
<td>0032090</td>
</tr>
<tr>
<td>Conductivity Calibration Kit (Low)</td>
<td>0032630</td>
</tr>
<tr>
<td>Conductivity Calibration Kit (High)</td>
<td>0032640</td>
</tr>
<tr>
<td>pH Calibration Kit</td>
<td>0032080</td>
</tr>
<tr>
<td>pH/ORP Calibration Kit</td>
<td>0032120</td>
</tr>
<tr>
<td>pH Storage Solution</td>
<td>0065370</td>
</tr>
<tr>
<td>Individual Calibration Solutions</td>
<td>See website</td>
</tr>
<tr>
<td>Ammonium Calibration Kit (includes 1 liter each: 14 ppm, 140 ppm, 1400 ppm, DI water)</td>
<td>0032140</td>
</tr>
<tr>
<td>Chloride Calibration Kit (includes 1 liter each: 35.5 ppm, 355 ppm, 3545 ppm, DI water)</td>
<td>0032150</td>
</tr>
<tr>
<td>Nitrate Calibration Kit (includes 1 liter each: 14 ppm, 140 ppm, 1400 ppm, DI water)</td>
<td>0032130</td>
</tr>
</tbody>
</table>

## Low-Flow

<table>
<thead>
<tr>
<th>Item</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Low-Flow Kit (includes flow cell with fittings and stake, base plate, documentation)</td>
<td>0066820</td>
</tr>
<tr>
<td>Flow Cell Kit</td>
<td>0066830</td>
</tr>
<tr>
<td>Flow Cell Base Plate</td>
<td>0044430</td>
</tr>
<tr>
<td>Fittings Kit</td>
<td>0093480</td>
</tr>
<tr>
<td>Pelican Case with foam insert</td>
<td>0066860</td>
</tr>
</tbody>
</table>

## RuggedCable System

RuggedCable Systems are custom-built, durable, direct-read cables that include the following items.

- Titanium twist-lock connectors for quick, reliable connections to the instrument, desiccant, and communication cable
- Metal shield beneath the cable jacket to prevent electrical interferences
- Kellems grip for secure instrument deployment
- Small desiccant for vented systems (for storage only)

⚠️ Non-vented cables are marked with VF, which means vent free.
Vented or Non-Vented Cable

Vented cable is used with vented pressure sensors to produce gauged measurements. The cable vent tube ensures that atmospheric pressure is applied to the back of the sensor diaphragm.

Non-vented cable is used with non-vented instruments for absolute measurements. Compensate absolute measurements by using a BaroTROLL Instrument and Win-Situ Baro Merge Software.

Vented cable is shipped with a small desiccant to protect against condensation. Larger desiccants are necessary for deployment.

Jacket Options

Tefzel (vented) or thermoplastic polyurethane (TPU, vented or non-vented)

Customizable Cable Lengths

Cables can be ordered up to 1,219 m (4,000 ft).

Cable Termination

Cables can be ordered with a twist-lock termination (female connector) on both ends that connect to the instrument, the TROLL Com Communication Device, desiccant, and other accessories.

Cables can also be ordered with stripped-and-tinned termination for wiring to a data logger or controller using SDI-12, analog (4-20 mA), or Modbus communication protocol.

1 RuggedCable System with female to female connectors
2 Stripped-and-tinned RuggedCable System with female connector
3 Stripped-and-tinned RuggedCable System with male connector (short length that converts a cable with a twist-lock connector to a stripped-and-tinned cable)
**Instrument Setup**

**Box Contents**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Documentation and software</td>
</tr>
<tr>
<td>2</td>
<td>Wiper motor and brush or wiper port plug</td>
</tr>
<tr>
<td>3</td>
<td>Aqua TROLL® 600 Sonde</td>
</tr>
<tr>
<td>4</td>
<td>Water quality sensors (2 of 4)</td>
</tr>
<tr>
<td>5</td>
<td>Water quality sensors (2 of 4)</td>
</tr>
<tr>
<td>6</td>
<td>RDO sensor cap</td>
</tr>
<tr>
<td>7</td>
<td>Accessory supplies*</td>
</tr>
<tr>
<td>8</td>
<td>pH/ORP sensor maintenance supplies</td>
</tr>
<tr>
<td>9</td>
<td>Extra sensors (0 to 2)</td>
</tr>
<tr>
<td>10</td>
<td>D-cell alkaline batteries (2)</td>
</tr>
<tr>
<td>11</td>
<td>Instrument tools†</td>
</tr>
</tbody>
</table>
Accessory supplies include wiper screws (3), wiper brushes (3), wiper brush holders (3), silicone lubricant for O-rings (2), RDO calibration sponges (3), battery compartment desiccant, replacement battery compartment hex screw driver, lens cloth, and micro SD card adapter.

† Instrument tools include a 0.050 in./1.3 mm hex screwdriver for sensor screws, a flathead screwdriver for the pH reference junction, and a Phillips head screwdriver for bail screws.

Install the Batteries

1. Twist open the battery compartment, remove the disposable desiccant pack in the battery compartment, and install the batteries.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Allen wrench (backup)</td>
</tr>
<tr>
<td>2</td>
<td>Replaceable desiccant</td>
</tr>
<tr>
<td>3</td>
<td>D-cell alkaline batteries</td>
</tr>
<tr>
<td>4</td>
<td>Micro SD card</td>
</tr>
</tbody>
</table>

Install two alkaline D-cell batteries. Use only alkaline batteries. Do not use batteries of different ages. For more information on batteries, see "Batteries" on page 47.

2. On the opposite side of the batteries is a back-up Allen wrench that can be used for sensor installation and removal.

3. Check to see that the replaceable desiccant capsule is blue indicating it is fresh. Replace the desiccant if it is pink.

4. Close the battery compartment. If the batteries are installed correctly the LCD screen will turn on.

Desiccant

The Aqua TROLL 600 contains a small, replaceable desiccant capsule in the battery compartment. This capsule prevents moisture from causing damage to the electronic components. It is filled with color-indicating silica that gradually changes from purple to pink as the desiccant's effectiveness decreases. Replace the desiccant when the desiccant has turned pink. The desiccant is included in the Aqua TROLL 600 Maintenance Kit (0078940).
Replace the Desiccant

1. Remove the battery cover.
2. Remove the backup wrench tool from the back of the battery compartment.
3. Insert the backup wrench into the small hole on the back side of the battery compartment and push the desiccant capsule out.
4. Insert a new desiccant capsule and push the capsule in fully using the wrench.

Install the Wiper Motor and Sensors

1. Remove the restrictor.
2. Remove the protective sticker from the end of the sonde to expose the sensor ports.

Rubber bumpers are included on the ends of the sonde to help prevent the sonde from rolling off working surfaces. You can deploy the sonde with or without these safeguards.

3. Locate the cylindrical wiper motor (or motor port plug) and remove the dust cap. Apply a small amount of lubricant from the maintenance supplies to the O-rings. Align the pins and push the motor (or plug) firmly into the center port.

Notice the blue sensor interlock grooves on the wiper motor. You must install the sensors so that they slide into the grooves.
The pH/ORP sensor is shipped with a storage cap taped on the sensor. Remove this cap before installation and save the cap for later storage.

Salt crystals may form on pH/ORP sensors during storage. These crystals are normal and do not impact sensor performance.

When installing an RDO sensor, install the RDO Cap before installing the sensor body on to the sonde. Do not touch or rub the cap face. Make sure the RDO cap is seated firmly and the tab is locked in place.

4. Locate the conductivity sensor. Remove the dust cap and apply lubricant to the conductivity sensor O-rings. Install the sensor into port 1 making sure the sensor tongue slides into the blue motor interlock groove.
Sensors can be installed in any port, however, installing the conductivity sensor in port 1 allows for the most efficient energy consumption.

5. Install the remaining sensors, applying lube to all O-rings. Sensors should be seated tightly together with no gaps between connecting edges or the instrument base.

6. When all sensors are installed, use the Allen wrench to tighten the screw at the base of each sensor. Do not overtighten the screws.

7. Place the metal restrictor over the sensors and twist into place. Ensure that the vent holes are located at the base of the instrument to allow sufficient flow to the sensors.

The restrictor can be inverted to act as a storage cup when the instrument is not in use. See "Instrument Storage" on page 130

Removing Sensors

1. Loosen the sensor screw.
2. Insert the Allen wrench into the small hole at the base of the sensor.
3. Push the wrench body towards the sensor so the inserted tip of the wrench rotates towards the sonde body.

4. Pull the sensor out of the port.
Connecting to the Sonde

Connecting RuggedCable

Connect the Instrument to the RuggedCable

1. Remove the protective caps from the instrument and cable. Ensure that the O-ring on the instrument connector is clean. Apply a small amount of vacuum grease to the o-ring.

2. Position the instrument and cable flat edges so they will connect properly. Insert the instrument connector firmly into the cable connector.

3. Hold the textured section of the sleeve in one hand and the instrument in the other. Push and twist until you hear a click. The click ensures the cable and instrument are securely attached.

Connect TROLL Com Communication Device to the RuggedCable System

1. If a desiccant is present, remove the desiccant from the cable. Twist the desiccant and cable sleeve in opposite directions to unlock the desiccant from the cable.

2. Position the TROLL Com and cable flat edges so they will connect properly. Push and twist until you hear a click.

Connecting with Bluetooth

The Aqua TROLL® 600 can connect to a Bluetooth-enabled device for wireless communication with the VuSitu Mobile App.

1. Turn on the Aqua TROLL 600 LCD screen by holding the sonde vertical with the sensor end facing up.

2. On the Bluetooth-enabled device, navigate to the Bluetooth menu and scan for available devices.

3. The Aqua TROLL 600 will be listed as "Serial Number - AT600". For example: 424690 - AT600. Tap the device name to pair the Aqua TROLL 600 and the Bluetooth-enabled device.

Connecting to VuSitu

1. Open the VuSitu Mobile App. If you have correctly paired your Aqua TROLL® 600 with your wireless device, and the instrument is available, the software will connect and display readings.

2. If the Searching screen continues to show, tap Choose another device and select the device you are trying to connect to.

Connecting to a Wireless TROLL Com

A Wireless TROLL Com can be used to connect the instrument to software if the sonde is deployed on a cable.

1. Turn on the Wireless TROLL Com.

2. Make sure the cable is connected to the instrument as well as the communication device.
3. Go to Bluetooth settings on your mobile device or computer.
4. From the Bluetooth section, search for devices.
5. Tap or click the serial number of the communication device to pair the device with the phone or computer. The serial number is located under the USB flap.

**Connecting to VuSitu**

1. Open the VuSitu Mobile App. If you have correctly paired your Wireless TROLL Com with your wireless device, and the instrument is available, the software will connect and display readings.

   ![Checkmark] If the Searching screen continues to show, tap "Choose another device" and select the device you are trying to connect to.

**Connecting to Win-Situ 5**

1. Open Win-Situ 5 Software.
2. When prompted, "Connect to device now?" click **No**.
3. Plug the USB charging cable into the computer and Wireless TROLL Com.
4. Click **Preferences**, then click **Comm Settings**.
5. Select the correct Com port used by the charging cable, then select the communication settings for the instrument you are connecting. The following default communication settings are most common for In-Situ instruments:
   - Baud: 19200
   - Data Bits: 8
   - Parity Bits: Even
   - Stop Bits: 1
   - Device Address: 1
   - Mode: Modbus-RTU

   If you cannot connect using these settings, click the "Search for Devices" or "Reset All Devices" button.
6. Click the checkmark, then click the Connect button in the lower right hand corner.

**SDI-12 3 Wire**
Modbus Master

Digital PLC
12-36 VDC*

EXT PWR RED

GND/RETURN BLACK

RS485 (–) GREEN

RS485 (+) BLUE

* Optional but highly recommended
Modbus Master with RS232 (Converter Required)

Digital PLC
12 VDC*

EXT PWR RED
GND/RETURN BLACK
RS232 (TXD)
RS232 (RXD)

Converter
Gnd +12V
RS485 (-) GREEN
RS485 (+) BLUE

* Voltage limited by converter

CONVERTER
Port-Powered RS485 converter, such as B&B Electronics Model 485SD9TB

REF PWR RED***
GND/RETURN BLACK***
RS485 (+) BLUE
RS485 (-) GREEN

*** Required if port power is not available
**Modbus PLC Interface Overview**

The Modbus PLC Interface is a simplified method of communicating with the Aqua TROLL® 600 using the Modbus protocol. It reduces programming complexity and allows the user to remove sensors and reinstall them in different ports. Please observe the following limitations when using this interface:

1. Only one sensor of any sensor model can be used in the sonde (for example: only one turbidity sensor can be installed).
2. If a parameter is provided by more than one of the installed sensors, the interface will return the first value available.
3. Firmware version 1.71 or later must be installed on the sonde.

For information about the full Modbus capabilities of your sonde, see the Aqua TROLL® 600 Interface Specification at www.in-situ.com/support/type/documentation.

**Setting Up the Instrument**

1. Install the sensors and turn on the display by holding the instrument vertically.
   a. Ensure the display turns on and check the LCD to ensure the sensors are working.
2. The setup below is using the instrument’s factory default settings. Use WinSitu or VuSitu to reset the instrument to factory defaults if they have been changed.
   a. Take note of any changes in default units setup.

**Wire the Modbus Master**

1. Connect the Twist-Lock termination to the instrument and wire the stripped-and-tinned connection as shown below:

   ![Diagram of connection](image)

**Programming the PLC**

1. Setup the serial communication the following values:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Start Bit</th>
<th>Baud Rate</th>
<th>Data Bits</th>
<th>Parity</th>
<th>Stop Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTU</td>
<td>1</td>
<td>19200</td>
<td>8</td>
<td>Even</td>
<td>1</td>
</tr>
</tbody>
</table>
2. Set the device address to: 1
3. Set the PLC to wake-up the device by sending any Modbus command.
   a. This could be a carriage return, reading the slave id or reading any register.
4. Read the discovery register using Appendix A to trigger the instrument to scan and map the sensors.
   a. The return value can be discarded.
   b. Each register is a holding register. Some PLCs require you to add 40000 to the register number or address. For example: 9301 would be 49301.
   c. Alternatively, you can prompt the instrument to update its sensor mapping by performing any of the following actions:
      a. Activating the instrument’s LCD screen;
      b. Connecting to the instrument via VuSitu or Win-Situ software;
      c. Running a log.
5. Select the register to read on the PLC using Appendix B
   a. Some PLC devices use the register number directly in programming statements, others use register addresses, which are one less than the register number; the programmer must adhere to the PLC’s programming style
   b. Each register is a holding register. Some PLCs require you to add 40000 to the register number or address. For example: 5451 would be 45451.
6. Set the type of register to: 32-bit float
   a. If asked by the PLC this is 2 registers
7. Set the byte order to: Big Endean (MSB)
   a. This should be the default and may not be configurable on all PLCs

Reading Parameters

To determine the starting register number for a given parameter register block, first determine its parameter ID by looking in the sensor’s parameter tables. Then calculate the starting register number of the parameter block using the following equation.

\[
\text{Starting Register} = (\text{Parameter ID} - 1) \times 7 + 5451
\]

For example, for the Conductivity Sensor, the parameter id for specific conductivity is 10 (bit 9 will be set in register 6984 if it is available). The starting register number for the specific conductivity register block is thus \( (10 - 1) \times 7 + 5451 = 5514 \).

The starting register for each parameter points to a block of 7 registers that contain the following information.

<table>
<thead>
<tr>
<th>Register Offset</th>
<th>Size (registers)</th>
<th>Mode &amp; Access Level (R/W)</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2</td>
<td>R1</td>
<td>float</td>
<td>Measured value</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>R1</td>
<td>ushort</td>
<td>Data quality ID</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>R1/W2</td>
<td>ushort</td>
<td>Units ID</td>
</tr>
<tr>
<td>Parameter ID</td>
<td>ID</td>
<td>Parameter Type</td>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>----</td>
<td>----------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>R1</td>
<td>ushort</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>R1/W3</td>
<td>float</td>
<td>Off line sentinel value</td>
</tr>
</tbody>
</table>

Continuing with the above example, to measure and read specific conductivity, read the two-register floating point value at register 5514 (starting register 5514 + offset 0 = register 5514). To read the corresponding data quality id, read register 5516 (starting register 5514 + offset 2 = register 5516). Block reads within the parameter block are allowed. The specific conductivity can be measured and read along with its data quality id by reading the 3 registers starting at register 5514, then extracting the measured float value and the data quality id.

Registers within the block that are marked as read/write, can be written as well as read. Refer to the sensor-specific parameter information for valid values.

**LCD Screen**

**LCD Screen**

The AquaTROLL 600 includes an LCD screen that allows you to view instrument status and access sonde settings.

**Turn on the LCD Screen**

1. Hold the sonde vertically so the sensor end faces up.
2. The LCD screen will illuminate after a few seconds briefly displaying the platform name and firmware version, followed by the RDO Sensor Cap expiration information (if applicable).
3. The LCD screen will then display port status, power status, log status, and connection status (when applicable).

Below is one example of how the LCD screen will appear when the instrument is ready to be deployed.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Status</td>
<td>Power Status</td>
<td>Log Status</td>
<td>Connected Status (shown only when connected)</td>
</tr>
</tbody>
</table>

**Status Icons**

**Possible Port Status**

- Sensors are installed

**Possible Power Status**

- Battery level indicator
### Possible Port Status

<table>
<thead>
<tr>
<th>Sensor Port Plugs are installed</th>
<th>External power provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor error</td>
<td>Battery error or Battery below 10%</td>
</tr>
<tr>
<td>Ports are open</td>
<td></td>
</tr>
</tbody>
</table>

### Possible Power Status

- External power provided
- Battery error or Battery below 10%

### Possible Log Status

<table>
<thead>
<tr>
<th>A log is running</th>
<th>Connected to software via Bluetooth</th>
</tr>
</thead>
<tbody>
<tr>
<td>A log is scheduled</td>
<td>Connected to software via cable</td>
</tr>
<tr>
<td>A log is paused</td>
<td></td>
</tr>
<tr>
<td>No log is configured</td>
<td></td>
</tr>
</tbody>
</table>

### Possible Connected Status

### Additional LCD Icons

- ** Instrument is working on a task. **
- ** Three taps on the instrument body allows access to the menu. ** A single tap selects the highlighted menu item.
- ** Tilt the instrument to the left to scroll up through the menu items. **
- ** Tilt the instrument to the right to scroll down through the menu items. **
- ** Indicates the top of the menu has been reached. **
- ** Indicates the bottom of the menu has been reached. **
- ** Consult the manual. **
Full-Text Messages

The LCD will display text messages instead of status icons when certain conditions are met. Multiple messages will rotate and display for 3 seconds each.

<table>
<thead>
<tr>
<th>Text Message</th>
<th>Cause and Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close battery cover</td>
<td>Battery cover is not fully closed. Ensure the battery cover is securely tightened.</td>
</tr>
<tr>
<td>Install wiper</td>
<td>Wiper sensor port is open. Install wiper or wiper port plug into center port.</td>
</tr>
<tr>
<td>Install sensors</td>
<td>Sensor ports are open. Install sensors or sensor port plugs.</td>
</tr>
<tr>
<td>Install temperature</td>
<td>No Temperature or Conductivity/Temperature sensor detected. Install a sensor with Temperature.</td>
</tr>
<tr>
<td>Install RDO Cap</td>
<td>RDO Cap not detected on RDO sensor. Install RDO cap.</td>
</tr>
<tr>
<td>RDO Cap expired</td>
<td>RDO cap is no longer valid. Install a new RDO Cap.</td>
</tr>
<tr>
<td>RDO Cap XXX days</td>
<td>Temporary text message update on the lifespan of the RDO Cap.</td>
</tr>
</tbody>
</table>

Sonde Menus

Sonde settings are accessed from menus displayed on the LCD screen. Within the sonde menus you can start or stop a simple data log, change the contrast or language settings, and update firmware for the sonde or sensors.

Accessing the Sonde Menus

1. Hold the sonde vertically so the sensor end faces up. The LCD screen will illuminate after a few seconds.
2. Wait until the LCD screen displays the status icons.
3. Hold the sonde horizontally and firmly tap the Aqua TROLL 600 Logo next to the LCD screen 3 times, pausing 1 second between taps.
4. The LCD screen will display the Main Menu along with arrow icons.
5. Tilt the sonde right or left to scroll through menu options.
6. To select a menu option, ensure it is highlighted with a black background and light text and firmly tap the Aqua TROLL 600 logo once.

Data Log Menu

The Data Log menu allows you to create and start a basic linear data log (if none has been set in Win-Situ 5 or VuSitu Software), or stop a log if it is running.

Start a Log

1. Access the data log menu.
2. Select New.
3. Select the desired reading interval. The data log will start once the interval is selected.

The data log will appear in Win-Situ with the Log Name "Aqua TROLL 600 SERIAL NUMBER," where SERIAL NUMBER will be the serial number of the unit. This log records all sensors and parameters and is a no wrap log. This means once the data capacity is reached the log will stop.

You are unable to update the instrument firmware while a log is running. Stop a log to update the sonde or sensors.

**Stop a Log**

1. Access the Data Log menu.
2. Select Stop.
3. Select Yes. The data log will stop.

**Contrast Menu**

The Contrast Menu allows you to adjust the contrast on the LCD screen.

1. Access the Contrast menu.
2. Tilt the sonde left to decrease (lighten) the contrast, or right to increase (darken) the contrast.
3. Tap the Aqua TROLL 600 logo to set the selected contrast.

**Language Menu**

The Language Menu allows you to set the default display language of the LCD screen.

1. Access the Language menu.
2. Highlight the desired language (English, Spanish, French, German).
3. Tap the Aqua TROLL 600 logo to set the selected language.

**Updates Menu**

The Updates Menu allows you to update firmware for the sonde or installed sensors.

1. Access the Updates menu.
2. Highlight the desired component to update (Sonde, Sensor 1 to 4).

If an update is present on the SD card, the screen will indicate the previous firmware version, a right-facing arrow, and the new version of the firmware.

3. Select Yes to update the firmware.

For more information on firmware updates, see "Updating Firmware" on page 48

**Batteries**

The Aqua TROLL 600 uses two standard D-cell 1.5 V alkaline batteries.
Battery Replacement

1. Open the battery compartment and remove both batteries.
2. Insert new batteries. Ensure the LCD screen turns on.
3. Replace the battery cover.

Never use lithium batteries, or batteries that are different ages or manufacturers.

In-Situ recommends using new batteries every time.

Micro SD Card

The Aqua TROLL 600 uses a micro SD card for data storage and updating sonde firmware. You can remove the SD card and replace it with another for data download, or use the same card. An SD card is not required to log data.

Removing the Micro SD Card

The micro SD card is housed in a slot near the positive battery terminal and the twist-lock connector.

1. Remove the battery cover from the end of the instrument.
2. Push the micro SD card in towards the instrument to release the card.
3. Remove the card from the slot.
4. To reinstall the card, note the card position diagram in the finger slot. Push the card into the slot until you hear a click.

Downloading and Deleting Data from the Micro SD Card

1. Remove card from the sonde and insert it into a micro SD card adapter.
2. Insert the adapter into a PC or laptop.
3. Open the micro SD card using the file explorer.
4. Open the folder titled "Serial Number.LOG." For example, "424690.LOG."

Logs are named by date and then number. For example, a log started on November 12, 2015 would be named "15111200.CSV" - 15 is the year, 11 is the month, 12 is the day, and 00 is the log number. If multiple logs are recorded on the same day the last number will increase by one for each consecutive log.

5. Select the logs you wish to download and move them to the destination.
6. Select the logs you wish to delete and press Delete on the keyboard. Deleted logs cannot be recovered.

Updating Firmware

1. Download the firmware update files to your computer.
2. Remove the SD card from the unit and insert it into your computer.

You may need a micro SD card adapter to connect the SD card to your computer. One is included with your Aqua TROLL 600, but any micro SD card adapter can be used.

3. Copy the firmware update files into the ISI.FW file on the SD card.
4. Install the SD card into the instrument and install the battery cover.

5. Turn on the LCD screen by inverting the sonde so the sensor end faces up.

6. Access the instrument menu by tapping the Aqua TROLL 600 logo on the yellow label three times. For more information on accessing menus, see “LCD Screen” on page 44.

7. Scroll to Updates by tilting the instrument. Access the Updates menu by tapping the Aqua TROLL 600 logo once.

8. Scroll to Sonde by tilting the instrument. Tap the Aqua TROLL 600 logo once.

9. The LCD screen will display the current firmware version on the left, then an arrow, and the new firmware version on the right.

10. Scroll to Yes by tilting the instrument. Tap the Aqua TROLL 600 logo once.

11. The LCD screen will display icons while updating. Once the update is complete the Aqua TROLL 600 and LCD screen will restart.

**Desiccant**

The Aqua TROLL 600 contains a small, replaceable desiccant capsule in the battery compartment. This capsule prevents moisture from causing damage to the electronic components. It is filled with color-indicating silica that gradually changes from purple to pink as the desiccant’s effectiveness decreases. Replace the desiccant when the desiccant has turned pink.

The desiccant is included in the Aqua TROLL 600 Maintenance Kit (0078940).

**Replace the Desiccant**

1. Remove the battery cover.

2. Remove the backup wrench tool from the back of the battery compartment.

3. Insert the backup wrench into the small hole on the back side of the battery compartment and push the desiccant capsule out.

4. Insert a new desiccant capsule and push the capsule in fully using the wrench.

**Sensor Calibration**

**Recommended Calibration Equipment, Accessories and Solutions**

**Laboratory/Office Calibration**

- Instrument with Restrictor and Cable Connection Protector
- Ring Stand or Bucket to hold instrument
- Calibration Solutions
- RDO Calibration Sponge or 100% Saturation Bubbler
- Running water or DI Squirt Bottle
- Sink
- Paper Towels

**Field Calibration**

- Instrument with Restrictor and Cable Connection Protector
- Ring Stand or Bucket to hold instrument
- Calibration Solutions
- RDO Calibration Sponge or 100% Saturation Bubbler
- DI Squirt Bottle or Bucket of Water
- Paper Towels

**Solution Based Calibration Preparation, Procedure and Rinsing**

Check the instrument storage requirements in the Aqua TROLL 600 manual prior to starting calibration.

1. Remove the rubber bumper and blue top cap from the restrictor.
2. Remove the restrictor and reattach in storage/calibration mode

3. Invert the instrument so the sensors are facing up.
4. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.
5. Take the first calibration solution and pour 10-20 mL (1/2” above the sensor face) of the calibration standard on top of the sensors to perform the first rinse.
6. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

7. Discard the rinse calibration solution.

8. Repeat steps 5-7. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has dampened the sensor face).

9. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.

10. Perform the sensor calibration using VuSitu Mobile app or Win-Situ 5 software.

11. Between new sensor calibrations or when performing a multi-point user calibration, remove the restrictor and thoroughly rinse the sensors and restrictor with water. Repeat solution rinse procedure (steps 5-7) prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

**RDO 100% Saturation Calibration**

For Win-Situ users: Before calibrating a non-vented sonde, unscrew the battery cover as shown in the image below to update the internal barometric pressure sensor. A check mark will appear on the LCD screen when the barometer is ready and the battery cover can be replaced.

1. Remove the rubber bumper and blue top cap from the restrictor.

2. Setup the instrument using one of the following methods:

   **Option 1 – Water Saturated Air**
- Remove the restrictor and thoroughly dry the RDO sensing foil and the temperature sensor.
- Make sure the restrictor is in calibration mode.

![Image of a restrictor](image)

- Saturate a small sponge with enough water to moisten the entire sponge (sponge does not need to be dripping). Place the sponge in the bottom of the restrictor. Attach the end cap. Turn one full rotation, but do not fully seal to the bottom of the restrictor. Allow 5-10 minutes for 100% water saturation of the air within the calibration chamber prior to starting the calibration.

  Over sealing the end cap can cause pressure to build up in the calibration cell and provide inaccurate readings. In addition, make sure the sensing element and thermistor are free of water droplets as this can also cause a deviation in readings.

**Option 2 - Saturation Bubbler**

- Fill a 100% saturation bubbler half full with tap water. Turn on the bubbler. (note: it typically takes 5-10 minutes for the bubbler to reach 100% saturation).
- Install the restrictor in deployment mode and attach end cap and place in the bubbler.

![Image of a saturated restrictor](image)

3. After the calibration chamber or bubbler have stabilized, perform the sensor calibration using VuSitu Mobile app or Win-Situ 5 software.
Verification of Calibration Accuracy

1. To verify the accuracy of the calibration, make sure that all solution has been removed from the sensors by removing the restrictor/calibration cell and rinsing in a large bucket of fresh tap water or distilled water.
2. Take the same calibration solution that was used to perform the calibration and pour 10-20 mL of the standard on top of the sensors to perform the first rinse.
3. Reinstall the blue top cap and gently shake to ensure all sensors and inside of the calibration cell have been in contact with the calibration solution.
4. Discard the rinse calibration solution.
5. Repeat steps 2-4. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face).
6. With the sonde and sensors still inverted, fill the restrictor with 40-50mL of fresh calibration solution. Make sure that the calibration solution is 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
7. Open the software and take a few readings to ensure the reading from the sensor is fully stabilized. Verify that the reading matches the expected value located on the outside of the calibration solution. If outside of sensor specifications, recalibrate.

Calibration Frequency Recommendations

In-Situ sensors are factory calibrated across the entire range of each sensor, and thus achieve a very high degree of accuracy and stability for extended periods of time without user calibration. In-Situ recommends inserting the instrument into a known calibration standard to check the accuracy of a sensor prior to performing any user calibration if you suspect drift, unless a user calibration is required by a standard operating procedure.

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Recommended User Calibration Frequency</th>
<th>Recommended Factory Calibration Frequency</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductivity</td>
<td>Only when required by user protocol</td>
<td>12 months</td>
<td><strong>K-cell value</strong>: 0.7 to 1.3</td>
</tr>
<tr>
<td>Conductivity + Temperature</td>
<td>Only when required by user protocol</td>
<td>12 months</td>
<td><strong>K-cell value</strong>: 0.7 to 1.3</td>
</tr>
</tbody>
</table>
| pH                            | 10 to 12 weeks or as required by user protocol or site conditions | 12 months | **Single point:** Theoretical mV ±30 mV  
2- or 3-point Slope:  
-66 to -50 mV/pH  
2- or 3-point Offset:  
±30mV at pH 7          |
| ORP                           | 10 to 12 weeks or as required by user protocol or site conditions | 12 months | **Offset**: ±30 mV |

---

Frequency: 12 months

Notes: **K-cell value**: 0.7 to 1.3
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Frequency</th>
<th>Calibration Duration</th>
<th>Slope/Offset</th>
</tr>
</thead>
</table>
| RDO            | 12 months or as required by user protocol | 12 months | **2-point Slope:** 0.7 to 1.3  
**2-point Offset:** ±0.3 mg/L |
| Temperature    | Only when required by user protocol | Only when required by user protocol | Offset: ±0.5 |
| Turbidity      | Only when required by user protocol | 12 months | **Slope:** 0.7 to 1.3 |
| Pressure/Depth | Only when required by user protocol | Only when required by user protocol | <2 times the full scale accuracy specification |
| Barometer      | Only when required by user protocol | Only when required by user protocol | <2 times the full scale accuracy specification |
| Ammonium       | Monthly            | N/A                   | Slope > 20 mV/decade |
| Chloride       | Monthly            | N/A                   | Slope < -20 mV/decade |
| Nitrate        | Monthly            | N/A                   | Slope < -20 mV/decade |
| Chlorophyll a  | Only when required by user protocol | 12 months |
| BGA-PC         | Only when required by user protocol | 12 months |
| BGA-PE         | Only when required by user protocol | 12 months |
| Rhodamine WT   | Only when required by user protocol | 12 months |

**Factory Calibration**

Factory calibration includes a thorough cleaning, full functionality check and sensor adjustments to all applicable sensors over the entire calibrated temperature range. We recommend a factory calibration every 12 months or when the unit appears to drift significantly.
Zeroing the Depth Sensor

The Aqua TROLL 600 uses its pressure reading and specific gravity value to calculate depth. The pressure sensor is located at the center of the instrument, but depth is reported at the smart sensor faces. An embedded gyroscope compensates for the distance between these sensors and allows the sonde to be deployed in any orientation (vertical, horizontal, angled).

⚠️ Do not zero the pressure sensor. Erroneous readings will result.

Water Level

Pressure Sensor

Depth to pressure sensor

Vertical distance between pressure sensor and smart sensors

Reported Depth

Error Codes

The Aqua TROLL 600 provides internal diagnostic information on each sensor, which is available in the data file on the SD card and can be viewed in Win-Situ 5. See the table below for a list of possible sensor errors and recommended actions.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Description</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>UC[0]</td>
<td>User Calibration (UC) Expired</td>
<td>1.) Perform a user calibration on the sensor in a known calibration standard 2.) Follow individual sensor instructions or user SOPs for calibration.</td>
</tr>
<tr>
<td>FC[0]</td>
<td>Factory Calibration (FC) Expired</td>
<td>Call (800-446-7488) or contact In-Situ Technical Support (<a href="mailto:support@in-situ.com">support@in-situ.com</a>). Send the instrument back to In-Situ for factory calibration</td>
</tr>
<tr>
<td>OL[0]</td>
<td>Sensor Office (OL) and no longer communicating with the instrument</td>
<td>1.) Remove sensor and check for water in the connection port. Dry sensor and sonde connector. Reinstall sensors. 2.) Remove two sensors and reinstall in separate port. 3.) Call (800-446-7488) or contact In-Situ Technical Support (<a href="mailto:support@in-situ.com">support@in-situ.com</a>).</td>
</tr>
</tbody>
</table>
**Software**

The Aqua TROLL® 600 can be programmed using the VuSitu Mobile App for Android, or using Win-Situ 5 Software.

**VuSitu Mobile App**

**Verify the VuSitu Mobile App Version**

To avoid potential compatibility issues, it is important to use the most recent version of the VuSitu Mobile App. Find version information and app updates from the Google Play Store.

**Connecting with Bluetooth**

The Aqua TROLL® 600 can connect to a Bluetooth-enabled device for wireless communication with the VuSitu Mobile App.

1. Turn on the Aqua TROLL 600 LCD screen by holding the sonde vertical with the sensor end facing up.
2. On the Bluetooth-enabled device, navigate to the Bluetooth menu and scan for available devices.
3. The Aqua TROLL 600 will be listed as “Serial Number - AT600”. For example: 424690 - AT600. Tap the device name to pair the Aqua TROLL 600 and the Bluetooth-enabled device.

**Connecting to VuSitu**

1. Open the VuSitu Mobile App. If you have correctly paired your Aqua TROLL® 600 with your wireless device, and the instrument is available, the software will connect and display readings.

   ![Checkmark] If the Searching screen continues to show, tap Choose another device and select the device you are trying to connect to.
VuSitu Overview

About VuSitu

VuSitu is the mobile user interface and control application for In-Situ water quality instruments. You can use VuSitu on mobile devices with Android operating system 4.4, Bluetooth 2.0 and newer. Download the latest version of the app from the Google Play Store at play.google.com.

VuSitu allows you to accomplish the following tasks.

- View live readings that update every 10 seconds
- Change parameters and units
- Set up a data log
- Record data
- Email data in spreadsheet format
- Download data to mobile device
- Transfer data from mobile device to a computer
- Organize data by Location
- Calibrate Sensors and View Reports

VuSitu Menu Options

The features available in the VuSitu mobile app vary slightly depending on the instrument to which it is connected. Tap the menu icon in the upper left portion of the screen to view the features included in VuSitu. Tap the menu icon again to close the menu.

Menu Options when Connected to Instrument

Some features, such as sensor calibration, are not available when you are not connected to an instrument.
Selecting with Long-press and Swipe

**Long Press**

Press and hold any item in a list of files. You can now select multiple files.

**Swipe Left**

Press an item and swipe left to reveal the delete and share icons.

**Swipe Right**

Press any item in a list and swipe right to reveal the sharing icon.
Taking live readings in VuSitu

**Snapshot Mode**

Take a single reading and save to Snapshot file.

View Snapshot file from Menu > Data Files.

Check Snapshot option.

**Live Readings Mode**

Take readings at two-second intervals.

View readings from Menu > Data Files.

Check Live option.
VuSitu Locations

About VuSitu Locations

A Location represents the physical location at which an instrument collects data. For example, you can create a Location to represent a lake, gauging station, well, tank, number, or nearby landmark. If you do not set up a Location, your data will be associated with Default Location. The Location name is displayed on the Live Readings screen. You can access Locations through the Main Menu or by tapping the Location displayed in the lower portion of the Live Readings screen.

Create a New Location

1. You can create a new Location with which to associate your data by selecting Locations from the main menu, or by tapping the location shown on the Live Readings screen.
2. Tap Add New Location.
3. Enter a name for the Location.
4. It is optional to add a photo to the Location. Tap the camera icon, take a photo and select the check mark to select the photo.
5. It is optional to add notes to the Location. Tap the Notes field to enter additional information about the Location.
6. It is optional to associate latitude and longitude coordinates with the Location. Tap the map to activate the mapping feature.
7. Tap the GPS icon in the upper-right portion of the screen to navigate to your current physical location.
8. Tap the Location icon to select the point on the map as the Location.
9. To manually set a Location, tap and hold to drop a pin on a specific area of the map. This associates latitude and longitude with your Location.
   - As an alternative, you can manually enter latitude and longitude values and tap Apply.
10. Tap Save.

Select a Location

Data is associated with the Location that is displayed on the Live readings screen.

After you have created a Location, you must select it in order for your data to be associated with the Location.
1. To Select a Location, tap the current Location displayed on the Live Readings screen. The list of Locations appears.

2. The active Location is marked with a green check mark. If no Location has been selected data will be associated with the Default Location.

3. Tap the desired location in the list.

4. The Live Readings screen appears with the site selected.
Edit or Delete a Location

1. From the Main Menu, tap Locations.
2. Tap the Location you want to edit.
3. Tap the Overflow Menu in the upper-right portion of the screen.
4. Select Edit Location to make changes, or Archive Location to remove it from the list.

Archived Locations can be restored at any time by tapping the Location, accessing the Overflow Menu and tapping Restore Location.

VuSitu Data

Downloading and sharing your data.

You can download VuSitu data as an HTML file and share it via email, SMS or a cloud storage service such as Google Drive. To download a log, select it from the Downloaded Data screen and tap Save to.
Choose one of the download options from the menu. You can transfer a data file from your mobile device to a PC via Bluetooth, email it to yourself or any valid email address, save the file to the VuSitu folder on your device or upload it to Google Drive.

View your data in any web browser by double-clicking the file. You can then export a CSV file by clicking the Export a CSV link at the top of the page.
VuSitu Calibration & Settings

About Calibration and Settings

You can perform sensor calibrations, view a calibration report, or restore factory calibration defaults when the instrument is connected to VuSitu.

1. Tap the VuSitu menu icon, and select Connected Instrument from the list.
2. Tap Calibrations.
3. Calibrations and settings for all connected sensors will appear. Ammonium, chloride and nitrate parameters are not shown in the image below but are displayed when the corresponding sensors are installed.
4. Tap the calibration you want to perform.

You can also access the full Calibration Report from this menu.

Quick-Cal Multiple Sensor Calibration

Quick-Cal allows you to perform a one-point calibration on up to three sensors with one setup and stabilization process.

1. From the main menu, select Connected Instrument.
2. Select Calibrations.
3. From the Calibration Menu, select Quick-Cal (multi-sensor).
4. All of the sensors available for the Quick-Cal calibration are selected by default. Tap the checked box if you want to exclude a sensor from the calibration.

5. Select **Next**.

   ![Checkmark Icon]

   If one or more sensors is not installed, an error message will pop up.

6. Make sure the restrictor is in calibration mode.
7. Invert the instrument so the sensors are facing up.

8. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

9. Take the Quick-Cal calibration solution and pour 10-20 mL (1/2” above the sensor face) of the calibration standard on top of the sensors to perform the first rinse.

10. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

11. Discard the rinse calibration solution.

12. Repeat steps 9-11. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to calibration solution contamination).

13. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

16. To rinse the sensors in between calibration solutions, remove the restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure (steps 9-11) prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

**Calibrate the Rugged Dissolved Oxygen Sensor (1-Point)**

The optical Rugged Dissolved Oxygen sensor is very stable. The factory calibration should produce readings within 3% accuracy. If you require readings with greater accuracy we recommend that you perform a 1-point, 100% water-saturated air calibration as described below.
100% Water-saturated Air Calibration

1. From the main menu, select Connected Instrument.
2. Select Calibrations.
3. From the Calibrations menu select RDO Saturation.
4. For a 1-point calibration, select 100% Saturation.
5. Remove the rubber bumper and blue top cap from the restrictor.
6. Setup the instrument using one of the following methods:

Option 1 – Water Saturated Air

- Remove the restrictor and thoroughly dry the RDO sensing foil and the temperature sensor.
- Make sure the restrictor is in calibration mode.

- Saturate a small sponge with enough water to moisten the entire sponge (sponge does not need to be dripping). Place the sponge in the bottom of the restrictor. Attach the end cap. Turn one full rotation, but do not fully seal to the bottom of the restrictor. Allow 5-10 minutes for 100% water saturation of the air within the calibration chamber prior to starting the calibration.

  Over-sealing the end cap can cause pressure to build up in the calibration cell and provide inaccurate readings. In addition, make sure the sensing element and thermistor are free of water droplets as this can also cause a deviation in readings.

Option 2 - Bubbler

- Fill a 100% saturation bubbler half full with tap water. Turn on the bubbler. (note: it typically takes 5-10 minutes for the bubbler to reach 100% saturation).
- Install the restrictor in deployment mode, remove the blue end cap, and place the sonde in the bubbler.

- After the calibration chamber or bubbler have stabilized, select **Next**.

7. After the calibration is stable, select **Accept**.

8. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

**0-point Calibration**

1. Make sure the restrictor is in calibration mode.

2. Invert the instrument so the sensors are facing up.

3. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

4. Take the Sodium Sulfite solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.

5. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

6. Discard the rinse calibration solution.

7. Repeat steps 4-6. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to calibration solution contamination).

8. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select **Next**.

9. After the calibration is stable, select **Accept**.

10. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

11. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.
Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

**Calibrating Using Concentration**

The preferred method of calibrating the RDO sensor is using the 1-point 100% Saturation calibration. However, you can also calibrate the sensor using a concentration method.

1. From the main menu, select **Connected Instrument**.
2. Select **Calibrations**.
3. Tap **RDO Concentration**.
4. Place the instrument in reference solution and tap **Next**.
5. Enter the value of the reference solution.
6. After the calibration is stable, select **Accept**.
7. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

**Calibrate the Rugged Dissolved Oxygen Sensor (2-Point)**

We recommend that you perform the 0 % oxygen calibration only if you intend to measure dissolved oxygen at a concentration of less than 2 mg/L.

**100% Water-saturated Air Calibration**

1. From the main menu, select Connected Instrument.
2. Select Calibrations.
3. From the Calibrations menu select RDO Saturation.
4. For a 1-point calibration, select 100% Saturation.
5. Remove the rubber bumper and blue top cap from the restrictor.
6. Setup the instrument using one of the following methods:

**Option 1 – Water Saturated Air**

- Remove the restrictor and thoroughly dry the RDO sensing foil and the temperature sensor.
- Make sure the restrictor is in calibration mode.
• Saturate a small sponge with enough water to moisten the entire sponge (sponge does not need to be dripping). Place the sponge in the bottom of the restrictor. Attach the end cap. Turn one full rotation, but do not fully seal to the bottom of the restrictor. Allow 5-10 minutes for 100% water saturation of the air within the calibration chamber prior to starting the calibration.

| Over-sealing the end cap can cause pressure to build up in the calibration cell and provide inaccurate readings. In addition, make sure the sensing element and thermistor are free of water droplets as this can also cause a deviation in readings. |

**Option 2 - Bubbler**

• Fill a 100% saturation bubbler half full with tap water. Turn on the bubbler. (note: it typically takes 5-10 minutes for the bubbler to reach 100% saturation).

• Install the restrictor in deployment mode, remove the blue end cap, and place the sonde in the bubbler.

• After the calibration chamber or bubbler have stabilized, select **Next**.

7. After the calibration is stable, select **Accept**.

8. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

**0-point Calibration**

1. Make sure the restrictor is in calibration mode.

2. Invert the instrument so the sensors are facing up.

3. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

4. Take the Sodium Sulfite solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.

5. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

6. Discard the rinse calibration solution.

7. Repeat steps 4-6. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to calibration solution contamination).
8. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

9. After the calibration is stable, select Accept.

10. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

11. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

   ![Warning]
   Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrating the Rugged Dissolved Oxygen Sensor Using Concentration

The preferred method of calibrating the RDO sensor is using the 1-point 100% Saturation calibration. However, you can also calibrate the sensor using a concentration method.

1. From the main menu, select Connected Instrument.
2. Select Calibrations.
3. Tap RDO Concentration.
4. Place the instrument in reference solution and tap Next.
5. Enter the value of the reference solution.
6. After the calibration is stable, select Accept.
7. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

RDO Salinity Setting

The Aqua TROLL® 600 includes automatic salinity compensation. This feature requires a conductivity sensor and RDO sensor. With both sensors installed, the sonde will use salinity compensation by default. To change the compensation value, follow these steps:

1. From VuSitu's main menu, select Connected Instrument.
2. Select **Instrument Settings** from the menu at the bottom of the screen.

3. From the Instrument Settings menu, select **Salinity Setting**.

4. Enter your desired salinity compensation setting and press **Save**.

---

**Calibrate the Conductivity Sensor**

1. From the main menu, select **Connected Instrument**.
2. Select **Calibrations**.
3. From the Calibration Menu, select **Conductivity**.
4. Make sure the restrictor is in calibration mode.

5. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.

6. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

7. Discard the rinse calibration solution.
8. Repeat steps 4-6. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to calibration solution contamination).

9. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face.

10. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

   The conductivity sensor can be impacted by small or large bubbles. Always check that no bubbles are present prior to performing a calibration.

11. The app attempts to automatically detect the calibration solution and stabilize the measurements.

12. Check your bottle of calibration standard to determine the reference temperature. If necessary, tap the drop down list and select the appropriate reference temperature for the calibration.
13. After the calibration is stable, select **Accept**.

![Conductivity Calibration](image)

14. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

15. Rinse the sensors and restrictor with DI water.

**Calibrate the Level Sensor**

The factory calibration of the level sensor is very accurate. In-Situ does not recommend calibrating the Level sensor unless your SOP specifically requires you to do so.

1. From the main menu, select **Connected Instrument**.
2. Select **Calibrations**.
3. From the Calibrations menu select **Level**.
4. Make sure that the pressure sensor is open to air and not submersed in water.
5. Select **Next**.
6. After the calibration is stable, select **Accept**.

**Calibrate the pH Sensor**

You can calibrate the pH sensor with either a 1-point, 2-point, or 3-point process.

1. From the main menu, select **Connected Instrument**.
2. Select **Calibrations**.
3. From the Calibrations menu select **pH**.
4. Select a 1-, 2-, or 3-point calibration.

5. Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.

7. Ensure the sensor face and inside of restrictor/calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2" above the sensor face) on top of the sensors to perform the first rinse.
9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

   If you are using a custom standard, the app will not automatically detect it. Instead, a field will appear in which you can enter the appropriate value. Select Set User Defined to begin calibrating with the new value. If you are not using a custom standard and the app does not automatically detect the standard, perform the sensor cleaning and maintenance procedure, then select Retry Auto Detect.

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

16. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

   ! Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

**Calibrate the ORP Sensor**

The ORP sensor can be calibrated using Zobell's standard, Quick-Cal or a custom ORP solution.

1. From the main menu, select Connected Instrument.
2. Select Calibrations.
3. From the Calibrations menu select ORP.
4. Make sure the restrictor is in calibration mode.

5. Invert the instrument so the sensors are facing up.

6. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

7. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.
8. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

9. Discard the rinse calibration solution.

10. Repeat steps 7-9. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to calibration solution contamination).

11. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

12. The app attempts to automatically detect the calibration solution and stabilize the measurements.

   If you are using a custom standard, the app will not automatically detect it. Instead, a field will appear in which you can enter the appropriate value. Select Set User Defined to begin calibrating with the new value. If you are not using a custom standard and the app does not automatically detect the standard, perform the sensor cleaning and maintenance procedure, then select Retry Auto Detect.

13. After the calibration is stable, select Accept.

14. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

15. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

   Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrate the Turbidity Sensor

You can calibrate the Turbidity sensor with either a 1-point, 2-point, or 3-point process.

1. From the main menu, select Connected Instrument.
2. Select Calibrations.
3. From the Calibrations menu select **Turbidity**.

4. Select a 1- or 2-point calibration.

5. Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.
7. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.

9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next

   The turbidity sensor can be impacted by small or large bubbles. Always check that no bubbles are present prior to performing a calibration. It can be difficult to see bubbles in high turbidity solutions.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

   You must calibrate the turbidity sensor with In-Situ's turbidity standard, or formazine. The app may not automatically detect the formazine concentration. Instead, a field will appear in which you can enter the appropriate value. Select Set User Defined to begin calibrating with the new value. If you are using an In-Situ standard and the app does not automatically detect it, perform the sensor cleaning and maintenance procedure, then select Retry Auto Detect.

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

16. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

⚠️ Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

**Calibrate the Ammonium Sensor**

You can perform a one, two or three-point calibration of the ammonium sensor with the VuSitu mobile app. For best accuracy, we recommend a two-point calibration in standards closest to the conditions in your testing environment.

⚠️ Condition the ammonium sensor for a minimum of two hours prior to calibration by soaking it in 140 mg/L ammonium as N standard or the highest standard to be used during calibration. For the best long term results, soak the sensor overnight.

1. From the main menu, select **Connected Instrument**.
2. Select **Calibrations**.
3. From the Calibrations menu select **Ammonium**.
4. Select a 2 point calibration.
5. Make sure the restrictor is in calibration mode.
6. Invert the instrument so the sensors are facing up.
7. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.
8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.

9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

   If you are using a custom standard, the app will not automatically detect it. Instead, a field will appear in which you can enter the appropriate value. Select **Set User Defined** to begin calibrating with the new value. If you are not using a custom standard and the app does not automatically detect the standard, perform the sensor cleaning and maintenance procedure, then select **Retry Auto Detect**.

14. After the calibration is stable, select **Accept**.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

16. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

   **Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.**
Calibrate the Chloride Sensor

You can perform a one, two or three-point calibration of the chloride sensor with the VuSitu mobile app. For best accuracy, we recommend a two-point calibration in standards closest to the conditions in your testing environment.

Condition the chloride sensor for a minimum of two hours prior to calibration by soaking it in 355 mg/L chloride standard or the highest standard to be used during calibration. For the best long term results, soak the sensor overnight.

1. From the main menu, select **Connected Instrument**.
2. Select **Calibrations**.
3. From the Calibrations menu select **Chloride**.
4. Select a 2 point calibration.
5. Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.
7. Ensure the sensor face and inside of restrictor/ calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.
8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.
9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

   If you are using a custom standard, the app will not automatically detect it. Instead, a field will appear in which you can enter the appropriate value. Select Set User Defined to begin calibrating with the new value. If you are not using a custom standard and the app does not automatically detect the standard, perform the sensor cleaning and maintenance procedure, then select Retry Auto Detect.

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select Done to return to the Calibration Menu.

16. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

   Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

**Calibrate the Nitrate Sensor**

You can perform a one, two or three-point calibration of the nitrate sensor with the VuSitu mobile app. For best accuracy, we recommend a two-point calibration in standards closest to the conditions in your testing environment.

   Condition the nitrate sensor for a minimum of two hours prior to calibration by soaking it in 140 mg/L nitrate as N standard or the highest standard to be used during calibration. For the best long term results, soak the sensor overnight.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select Nitrate.

4. Select a two point calibration.
5. Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.

7. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the first rinse.

9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.
If you are using a custom standard, the app will not automatically detect it. Instead, a field will appear in which you can enter the appropriate value. Select **Set User Defined** to begin calibrating with the new value. If you are not using a custom standard and the app does not automatically detect the standard, perform the sensor cleaning and maintenance procedure, then select **Retry Auto Detect**.

14. After the calibration is stable, select **Accept**.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all sensors, or select **Done** to return to the Calibration Menu.

16. To rinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with deionized water to remove all calibration standard. Rinse twice with calibration standard.

   ![Caution](image)

   Not removing all of the previous calibration solution can contaminate the next solution thus impacting the accuracy of the next calibration or cause much slower sensor response.

---

**Win-Situ 5**

**Verify the Win-Situ Software Version**

To avoid potential compatibility issues, it is important to use the most recent version of Win-Situ Software. Find version information and the most recent software download on the In-Situ website [www.in-situ.com](http://www.in-situ.com).

---

**Win-Situ 5 Screens and Buttons**

**Data Tab**

When you open Win-Situ 5 Software, the **Data** tab appears. The left side of the screen contains a file tree where you can view previously downloaded site data as well as data you have exported to Microsoft Office Excel. The links on the right side of the screen show where downloaded data are stored on your computer. The disconnected plug icon in the lower-right corner of the screen indicates that the software is not yet communicating with an instrument.
<table>
<thead>
<tr>
<th>Screen Element</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Disconnected Plug" /></td>
<td>The disconnected plug indicates the instrument is not communicating with the software. Click to establish communication with a connected instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Connected Plug" /></td>
<td>The connected plug indicates the instrument is communicating with the software. Click to disconnect the software from the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Home Tab" /></td>
<td>The <strong>Home</strong> tab displays real-time readings from the instrument. When connection to the instrument is first established, the software displays one reading of all available parameters in light gray. You must click the <strong>Play</strong> button at the bottom of the screen to view real-time readings.</td>
</tr>
<tr>
<td><img src="image" alt="Logging Tab" /></td>
<td>The <strong>Logging</strong> tab displays a list of logs stored in the connected instrument. When you click the <strong>Logging</strong> tab, it can take a moment for the software to retrieve information from the instrument. (Not applicable for the RDO PRO-X and the Aqua TROLL 400.)</td>
</tr>
<tr>
<td><img src="image" alt="Sensors Tab" /></td>
<td>The <strong>Sensors</strong> tab lists the sensors in the connected instrument, along with their serial numbers and the dates of factory calibration and user calibration. Use the buttons in this tab to calibrate sensors that support user calibration and configure sensors that are supported by the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Device Setup Tab" /></td>
<td>The <strong>Device Setup</strong> tab allows access to instrument information and settings such as instrument name, serial number, firmware version, communication settings, diagnostics, and factory reset options.</td>
</tr>
</tbody>
</table>
The **Home** tab displays real-time readings from a connected instrument. When you first establish communication, the software displays one reading of all available parameters in light gray.

---

**Screen Element** | **Definition**
--- | ---
![Sites button](image) | The **Sites** button allows you to add, edit, or delete a site. Click the drop-down arrow next to the button to view the list of sites.

![Device Memory gauge](image) | The **Device Memory** gauge turns yellow when the internal memory is used. Note: Non-logging instruments do not have internal memory, however, the gauge shows 100 percent green when power is applied.

![Device Battery gauge](image) | The **Device Battery** gauge turns yellow as the battery is depleted. This example shows 80 percent of the battery remaining (green) and 20 percent used (yellow). Note: Non-logging instruments do not have internal batteries, however, the gauge shows 100 percent green when power is applied.
<table>
<thead>
<tr>
<th>Screen Element</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The Logging Status</strong> icon:</td>
<td>Green—The instrument is actively logging data.</td>
</tr>
<tr>
<td></td>
<td>Gray—The instrument has no logs pending or running. Non-logging instruments always show a gray status icon.</td>
</tr>
<tr>
<td></td>
<td>Yellow—The instrument has log data that was collected according to specific instructions in the &quot;Pending&quot; or &quot;Suspended&quot; state.</td>
</tr>
<tr>
<td><strong>The Alarm</strong> icon provides additional instrument status information.</td>
<td>Green—No alarms or warnings</td>
</tr>
<tr>
<td></td>
<td>Yellow—One or more warnings</td>
</tr>
<tr>
<td></td>
<td>Red—One or more alarms</td>
</tr>
<tr>
<td></td>
<td>Move the cursor over the alarm icon to view a description. Click the <strong>Device Setup</strong> tab for detailed information on the alarm or warning.</td>
</tr>
<tr>
<td></td>
<td>Note: Disregard the <strong>Device Reset</strong> alarm for non-logging instruments such as the RDO PRO Probe or the Aqua TROLL 400.</td>
</tr>
<tr>
<td><strong>System Time</strong> is displayed on the left. <strong>Device Time</strong> is displayed on the right. Clocks are updated once every two seconds. When the <strong>Device Time</strong> is displayed in red, it differs from the current <strong>System Time</strong>, and should be synchronized.</td>
<td></td>
</tr>
<tr>
<td><strong>The Time Sync</strong> button is used to write the current PC time to the instrument. If you need to set the instrument clock to a time other than the system (PC) time, use the <strong>Set Clock</strong> button on the <strong>Device Setup</strong> tab.</td>
<td></td>
</tr>
<tr>
<td><strong>Meter View</strong> shows the last known parameter values, displayed with current units and time stamp. Readings are sized to occupy the entire screen. This is the default display in the <strong>Home</strong> tab. If the type is black, the readings are updating in real time.</td>
<td></td>
</tr>
<tr>
<td><strong>List View</strong> is a running list of the most recent records. New readings are continuously added to the top of the list and old readings scroll off the bottom.</td>
<td></td>
</tr>
<tr>
<td><strong>Graph View</strong> shows a real-time trend graph of the selected parameters.</td>
<td></td>
</tr>
</tbody>
</table>
Screen Element | Definition
--- | ---
.snapshot | The **Snapshot** button records one set of readings.
.record | The **Record** button logs data to a CSV file that can be opened in a spreadsheet program. This is not the same as recording data in a log on the instrument.

**Logging Tab**

The **Logging** tab displays a list of logs in the instrument. When you click the **Logging** tab, it may take a moment for the software to retrieve information from the instrument.

![Logging Tab](image)

**Log Information**

Columns across the **Logging** screen show information about the logs in the instrument.

- **Symbol**—This is a graphic representation of the information in the **Status** column.
- **Site**—The site that was specified when the log was configured.
- **Log Name**—The name that was entered when the log was configured.
- **Type**—The logging method that was selected when the log was configured.
- **Start Time**—For a Pending log, the scheduled start time is shown. For a Ready log that has not yet started, this column displays “Manual.” For a Running or Stopped log, the actual start time is shown.
- **Scheduled Stop Time**—For a log with a scheduled stop, the scheduled stop time is shown. For a log without a scheduled stop time, this column is blank.
- **Stop Time**—For a Pending or Ready log, this column is blank. For a Running log, the time of the last data point is shown. For a Stopped log, the actual stop time is shown.
- **Status**—Each log has a specific status. See **Log Status** for details.
- **Used Size**—Kilobytes of instrument memory allocated for this log. For a Pending or Ready log, the current size of the log configuration is shown. For a Completed log, the size of the entire log file is shown. For a Running log, the current size of the log up to the last data point is shown.

### Log Status

The status of each log in the instrument is displayed in the Logging tab by a symbol beside the log name, and in the Status column.

- **Ready**—Manual Start log is ready to start.
- **Pending**—Scheduled start log is ready to start at its programmed time, or when you click the Start button.
- **Running**—The log is actively logging data.
- **Suspended**—The log has been paused (stopped temporarily).
- **Stopped**—The log has been stopped, either manually or on a schedule.
- **Deleted**—The log has been marked for deletion and will be deleted from the instrument when memory is needed. The software manages this automatically.
- **Invalid**—The log as programmed cannot be run.

**Ready, Pending, Running, and Suspended** logs are considered active. Only one log can be active in the instrument.

### Log Control Buttons

You can control the status of a log by selecting the log and clicking the appropriate button in the Logging tab control panel:

- The **Start** button starts a Ready or Pending log, or resumes a Suspended log.
- The **Pause** button pauses a Running log allowing you the option to resume it.
- The **Restart** button restarts the selected Running log from the beginning. This can be useful during aquifer testing using a logarithmic data collection schedule.
- The **Stop** button permanently stops the selected Running log.

### Log Operations

Use the buttons in the control panel to perform the following actions:

- **Create** a new log.
- The **New** button is disabled if a Ready, Pending, Running, or Suspended log is on the instrument. When the instrument contains its maximum number of logs, the New button is unavailable.
- **Edit** (or review) the log configuration for a Ready, Pending, or Invalid log.
- **Delete** the log. (Note that you must delete a log twice before it is permanently removed.)
- **Download** the log to a PC.

### Sensors Tab

The **Sensors** tab lists the sensors in the instrument, along with their serial numbers and calibration dates. Use the buttons in this tab to calibrate and configure sensors.
Calibrate

Use the **Calibration** button to calibrate sensors or to adjust a level reference that is currently stored on the instrument. The **Calibrate** button is not available when the instrument does not support calibration (e.g. BaroTROLL Instrument).

1. With the instrument connected to the software, select the **Sensors** tab.
2. Select the parameter you intend to calibrate.
3. Click the **Calibrate** button.

Configure

Use the **Configure** button to select parameter units and to configure parameters that support configuration. Examples include Level/Depth, Specific Conductivity, and Total Dissolved Solids. Parameters cannot be configured while the instrument is showing live data on the **Home** screen or while the instrument contains an active log.

1. With the instrument connected to the software, select the **Sensors** tab.
2. Select the parameter you intend to configure.
3. Click the **Configure** button.

When you configure the Level parameter using the **Sensors** tab, the settings are stored in the instrument and are available for use in Modbus, SDI-12, or analog communication (if available). If desired, a different configuration can be selected when setting up a log.
Device Setup Tab

The **Device Setup** tab allows you to set hardware settings and view instrument status such as:

### Device Information

- You can set the instrument name here. There is a 32-character limit. Type the name and click the **Set Name** button. A device name cannot be set while the device contains an active log.
- The other device-specific information displayed in this area is not user-changeable.
- **Manufacture Date**
- **Firmware Version**—If the firmware version is displayed with a red background, this indicates a later version is available and the device should be updated.
- **Hardware Version**
- **Boot Version**—This is the software used by the device to upgrade its firmware.

### Manual Time Set

You can set the instrument clock to a time other than the PC (system) clock. Select the new time and click the **Set Clock** button.

### Device Firmware Update

The **Available Firmware** drop-down list in the **Device Setup** tab displays all available firmware for the connected device arranged by version from newest to oldest. To update the device firmware, select the firmware version you want from the drop-down list and click the **Update Device** button. Firmware cannot be upgraded while the device is profiling or contains a log in the Ready, Pending, Running, Suspended, or Invalid state, as shown on the **Logging** tab. Downgrading the device to a lower firmware version is not recommended.

### Device Status

This area of the **Device Setup** tab shows the details of instrument alarms and warnings indicated by the bell-shaped alarm icon.

**Status colors:**
- Gray—No alarms or warnings
- Yellow—Warning
Red—Alarm

- Sensor High: An alarm or warning when values reported by a sensor have exceeded a user-set "high" alarm or warning threshold.
- Sensor Low: An alarm or warning when values reported by a sensor have dropped below a user-set "low" alarm or warning threshold.
- Sensor Calibration: A warning when factory calibration expires or when a user calibration date has passed.
- Sensor Malfunction: This alarm lights when a water-quality sensor malfunctions.
- Hardware Reset: This warning indicates that the device has reset itself following a serious interruption, such as a lightning strike. If the device clock is lost during logging, the log will resume when the device recovers from the reset, at whatever time is then active in the device. Disregard this warning for non-logging instruments.
- Device Malfunction: An alarm is activated when the device has malfunctioned. Call Technical Support.
- Low Battery: An alarm is activated when 5 percent of the device battery capacity remains.
- Low Memory: An alarm is activated when 5 percent of the device memory capacity remains.

Buttons in this area of the Device Setup tab are used to set up alarms, clear alarms, and take the device offline. To clear an alarm indicator, click the Clear Status button.

Factory Reset
To restore factory settings in the device (less any firmware upgrades), click the Factory Reset button in the Device Setup tab.

A factory reset removes all logged data from the device. This button is not available if the device is profiling or contains an active log.

Analog Setup
To configure the device for 4-20 mA output, click the Analog Setup... button in the Device Setup tab. Analog is not supported on all instruments.

SDI-12 Setup
To configure the SDI-12 output from the device, click the SDI-12 Setup... button in the Device Setup tab.

Alarm Setup
To configure the instrument alarm and/or warning indicators, click the Alarm Setup... button in the Device Setup tab.

Modbus Setup
These settings permit devices on a network and devices connected via a gateway such as a modem or TCP/IP to be changed independent of the connection link. To configure the device communication settings, click the Modbus Setup... button in the Device Setup tab.

Win-Situ 5 Logging and Viewing Data

About Sites
All data logged by In-Situ instruments are tied to a specific site. A site represents the physical location where the instrument collects data. For example, you can create a site to represent a lake, gauging station, well, or nearby landmark.

You are prompted to select a site when you set up a data log. A default site is loaded with the software, and can be used, but it does not provide any specific information about the place where the data was collected.

- When you set up a new site, a Site folder with the same name is created in the folder tree on the Data tab. Site folders are designated by this icon 
- When you set up a data log, the first thing you are asked to supply is a site.
When you download a data log, it appears in its **Site** folder in the folder tree on the first screen Data tab. See page 87. This provides a convenient way to organize data collected from the same instrument at different locations, or from different instruments at a common location.

Sites are stored in a database on your computer in your Win-Situ working directory. **More information.** After a new site is added, it is available to select for any instrument and any log.

Only one site at a time is programmed in the instrument and it is shown in the Site box at the top of the screen.

For additional information see:

- Adding a New Site
- Managing Sites

**Logging Data—Overview**

Win-Situ provides many ways to customize the collection of field data.

- Schedule the instrument to start and stop a log at a specified time.
- Set up a log and start it manually. While the instrument is connected to the software, you can watch the first few readings in tabular or graphical form. Disconnect from the software and let the instrument collect data. Manually reconnect to the instrument and download the collected data at any time.
- Start a log, check the data, pause the log, reposition the device, restart the log.
- Download data logs to folders on your PC.

**What do you want to do?**

- Set up a new data log.
- Start a log that has been set up in the instrument.
- View the logs on the instrument.
- Download a log to my PC.
- Stop a log that is running on the instrument.
- Suspend (temporarily stop) a log that is running in the instrument.
- Delete a log from the instrument.

**Logging Method Descriptions**

The following is a list of log types and their descriptions. The log types that are available on an instrument vary depending upon the capabilities of the instrument.

**Logging Methods for Long-Term Monitoring**

**Linear**

Linear log type measures and records at a user-defined fixed interval of one minute or more. This method is used for long-term studies, landfill monitoring, stream gauging, tidal studies, and background monitoring prior to aquifer testing. Intervals are measured in days, hours, or minutes.

**Linear Average**

Linear Average log type can smooth out anomalous highs and lows that may occur in a data set, for example, when a water wave passes over the instrument. Each stored measurement is the average of several rapid measurements. This method is used for long-term studies, stream gauging, tidal and open-water studies where trends are more important than accuracy. Intervals are measured in days, hours, minutes, or seconds.
Event

Linear Event log type combines basic fixed-interval logging of specified parameters with the ability to log data at a faster interval when a single-parameter event condition is present.

When logging conductivity, please note that the faster event interval logging can occur only if external power is present.

Log Setup

The Log Setup Wizard presents sequential screens to help you supply all the information necessary to set up a data log in the instrument.

To access the Log Setup Wizard the instrument must be connected to the software.

1. Click the Logging tab.
2. Click the New button.

The New button may be disabled or may show a warning if an active log already exists on the instrument, or if the instrument is polling live data (see the Home screen), or if the device already contains its maximum number of logs.

3. Select the Site where the set of data will be logged and supply a name for the log.
4. Click the right arrow to continue after each step.
5. Select the parameters you intend to measure, choose the measurement units, and specify the order in which the selected parameters will be logged.
6. Select the logging method you intend to use. See page 96.
7. Select the log interval. A log interval is how often a measurement will be taken and stored.
8. Select the start condition, stop condition, and specify how to handle full device memory.
9. If you selected Level or Depth as a parameter to measure, specify how you intend to log this parameter. More information.
10. If you selected Specific Conductivity as a parameter to measure, you have the option to choose a method for converting actual conductivity to specific conductivity.
11. If you selected Total Dissolved Solids as a parameter to measure, you have the option to edit the default conversion factor used to calculate total dissolved solids from specific conductivity.
12. The final screen summarizes the log setup. Click the check mark to write this information to the instrument.

Starting a Log

Every log is programmed for either a manual or a scheduled start. A log with a manual start time is displayed in the Logging screen with Ready in the Status column. A log with a scheduled start time is displayed with Pending in the Status column.

Starting a Pending Log

A Pending log automatically starts at the scheduled time without any user intervention.

A scheduled log with Pending status can be manually started at any time before its scheduled start.

Starting a Manual Log

With the instrument connected to the software, select the Logging tab.

Select the Ready log you want to start.
Click the **Start Log** button. The log starts and the symbol changes. The **Status** column displays **Running**.

### Suspending (Pausing) a Log

A running log may be temporarily paused. For example, you might want to reposition an instrument, calibrate a sensor, or clean a sensor and later resume the log. A log can be suspended and resumed three times.

1. With the instrument connected to the software, select the **Logging tab**.
2. Select the log you intend to suspend.
3. Click the **Suspend button**. **Suspended** appears in the **Status** column.

### Resuming a Suspended Log

1. To resume logging after a log has been suspended, select the **Logging tab**.
2. Select the **Suspended log**.
3. Click the **Start Log button**. Logging resumes. **Running** appears in the **Status** column. The data file will show the time when the log was suspended and the time when it restarted.

### Stopping a Log

A log can be manually stopped at any time, even if a stop time has been previously scheduled. If you did not specify a stop condition when you defined the log, the log will run until the instrument is out of memory or battery power, or until you manually stop it.

A log that has been stopped cannot be resumed. If you intend to resume a log later, you should suspend a log rather than stop it.

1. To manually stop a log, the instrument must be connected to the software.
2. Select the **Logging tab**.
3. Select the running log you intend to stop.
4. Click the **Stop Log button**.

### Restarting a Log

Restarting a log is useful when you are conducting aquifer testing and you want to begin collecting rapid data without configuring and starting a new log.

1. The **Restart Log** feature is only available for a running log. In the **Logging** screen select a running log.
2. Click the **Restart Log button** to restart the log from the beginning.

To resume a suspended log, use the **Start Log button**, not the **Restart Log button**.

### Downloading Data to a PC

This procedure copies the data log from the instrument to a PC. It does not remove the data log from the instrument. After a log is downloaded, it can be exported to a CSV file format that can be used by spreadsheet programs. The time shown in the log name is the time the log was downloaded.
1. With an instrument connected, select the **Logging** tab.

2. Select the log you intend to download.

3. Choose a Running, Suspended, Stopped, or Deleted log.

4. Click the **Download** button.

5. In the next screen, select one of the three download options.
   - All data
   - New data (data logged since the last download)
   - Time interval to download

   New data is downloaded by default to a new log file. To append new data to the last download of this log, be sure the option "Append logs on download" is selected in the **General Settings** dialog (Preferences > General Settings).

2. The log is copied to the connected PC into your Win-Situ working directory folder. View or change the working directory using **File > Settings**.

3. At the end of the download, Win-Situ gives you the option of viewing the data.
   - Select **Yes** and the log is displayed in the **Data** screen.
   - Select **No** and the **Logging** screen appears. You can view the data at any time by selecting it in the **Data** tab.

**Viewing Logged Data**

1. To view the data stored in the instrument, you must first download the data. A connection to an instrument is not needed after the data log has been downloaded.

2. Select the **Data** tab.

3. On the left side of the screen, select the log you want to view. To expand a folder shown in the navigation tree, double-click the folder. The content of the data log is displayed on the right side of the screen in text or graph format.

   To switch between view formats, click the **Text** or the **Graph** button in the control panel.
   To customize the text or graph view, select Preferences > Graph Settings or Preferences > Data View Settings. These options apply to all downloaded data until you change the options.

**Exporting Data**

**Exporting Data to Spreadsheet Format**

1. Download the log from the instrument to your PC.

2. Select the **Data** tab.

3. On the left side of the screen, select the log you intend to export. The content of the log is displayed on the right side of the screen.
To export all the logs in the site, select the site.

4. Select File menu > Export to CSV. The log is exported to the Exported Data folder into a sub-folder with the same name as the data site of the log. If the folder does not yet exist, Win-Situ creates it.

5. To open the CSV file, do one of the following:
   - Double-click the exported file in the navigation tree on the left side of the Data tab
   - Access the file in Windows Explorer and double-click the file (for example: C:\ My Documents \ Win-Situ Data \ Exported Data \ my data site \ drawdown test 2006-05-28 11-00-00).

Exporting to Text

To export one or more data logs to text format, follow the steps above, except at step 5 select File menu > Export to Text. Double-click the exported file to open it in Windows Notepad or your default text editor.

Graphing Data

Real-time data and downloaded log data may be viewed in text (default) or graphic form.

View a Graph of a Downloaded File

1. Click the Data tab.
2. Select a downloaded log file from the list on the left. Log files are located in the site folders.
3. Click the Graph button.

View a Graph of Real-Time Data

1. With an instrument connected to the software, click the Home tab.
2. Click the Start button.
3. Click the Graph button.

Graph Settings

The initial display uses the default graph settings (Preferences menu > Graph Settings) for all graphs. Each log file can have its own customized graph settings that are saved with the log file.

The defaults are as follows.

- All log channels are shown in the order in which they were logged.
- X axis (time) is across the bottom and is auto-scaled.
- Y axis (values), one for each channel, are stacked along the left side of the graph and are auto-scaled to show the full range of the data.

Graph Templates

If you have saved any custom graph templates, you can select one with the Load Template button.

Graph Tools

The graph control tools are described below. Each has a toolbar icon and a keyboard shortcut. Holding down the shortcut keys temporarily switches the graph control mode. When the shortcut is released, the graph returns to its previous control mode.
<table>
<thead>
<tr>
<th>Name</th>
<th>Tool</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan</td>
<td>![Hand]</td>
<td>Click the tool, then drag inside the graph to pan in any direction (left, right, up, down). Real-time graph update is paused (play button pops up) but the cache continues to update in the background.</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>![Plus]</td>
<td>Click the tool, then click in an area of the graph to enlarge that area. Or drag a selection box over a part of the graph you want to see in greater detail.</td>
<td>Ctrl + Spacebar</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>![Zoom]</td>
<td>Click the tool, then click in the graph and the graph zooms out on that area.</td>
<td>Ctrl + Alt + Spacebar</td>
</tr>
<tr>
<td>Cursor</td>
<td>![Arrow]</td>
<td>Click to cancel the Pan or Zoom tool.</td>
<td>Release shortcut key(s)</td>
</tr>
<tr>
<td>Series Select</td>
<td>![Series]</td>
<td>With the Data panel displayed, click the tool, then slide it left or right over the traces. The Data panel table scrolls to the selected record.</td>
<td>None</td>
</tr>
<tr>
<td>Fit Graph</td>
<td>![Fit]</td>
<td>After panning or zooming, this tool restores the default range settings for the axes.</td>
<td>Ctrl + 0 (zero)</td>
</tr>
<tr>
<td>Configure</td>
<td>![Configure]</td>
<td>Format and create templates for graphs.</td>
<td>None</td>
</tr>
<tr>
<td>Printing</td>
<td>![Print]</td>
<td>Print graph.</td>
<td>None</td>
</tr>
</tbody>
</table>

You can expand or compress the graph by clicking and dragging anywhere in the X axis on the bottom of the graph. The real-time graph update is paused but the cache continues to update in the background.
Calibration

Calibrate Sensors

1. Ensure that the instrument is connected to the software, and select the Sensors tab.

2. Select the sensor you want to calibrate to activate the Calibration button. Only sensors connected to the sonde will be displayed. Ammonium, chloride and nitrate sensors are not shown in the image above but are listed when those sensors are installed.

3. Click the Calibration button.

4. Perform the steps in the calibration wizard.

Calibrating the Conductivity Sensor

The conductivity sensor is calibrated with NIST®-traceable standards at the factory, which provides a high degree of linearity across the entire operating range. This sensor is capable of meeting its published specifications without requiring additional calibration by the user. Most commercially available standards can introduce a larger potential measurement error than the sensor’s initial factory calibration.

User calibration is recommended only if you must conform to a standard operating procedure or if the conductivity cell has undergone physical change (e.g., deposits on conductivity cell walls that cannot be removed or physical damage to the conductivity cell walls).

1. Prepare the instrument for calibration.

   There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations. For the greatest accuracy, keep the conductivity cell submersed in water for 24-48 hours prior to calibration and deployment.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the conductivity sensor.
5. Click the **Calibrate** button.

If you want to restore the factory calibration, select the check box and click the **right arrow** button.

6. Select either **20° C** or **25° C** as the reference temperature, as indicated by the reference calibration solution.

7. Select the appropriate calibration standard from the drop-down list. If you select "User Defined," enter the value of the solution.

8. Click the **right arrow** button.

9. Click **OK** to start the calibration.
Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or click Cancel to return to the previous calibration.

11. You can save or print the calibration report.

12. Click OK to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

Calibrating the Pressure Sensor

When a vented instrument is in air (rather than deployed in water) and displays a pressure/level value other than zero, you can calibrate to compensate for electronic drift. If the sensor reading is outside the specified accuracy of the pressure sensor, send the instrument to In-Situ for factory calibration.

Do not calibrate an absolute pressure sensor because this removes barometric pressure (at a single point in time) and causes errors when you post correct the data using a BaroTROLL Instrument.

1. Connect the instrument to the computer.
2. Connect the instrument to the software.
3. Go to the Sensors tab and select the sensor.
4. Click the **Calibration** button.

5. Select the pressure parameter from the drop-down list and select **Calibrate**.

6. Select the **Zero the Level/Pressure sensor** option.

7. Ensure the pressure sensor is dry and exposed to air.

8. Click the **check mark**. The pressure reading is reset to zero.

**Calibrating the RDO Sensor**

You can perform a one-point 100% Oxygen Saturation calibration or a two-point calibration that also includes a 0% Oxygen calibration depending on your application needs.
**Calibrate 100% Oxygen Saturation**

1. Prepare the instrument for 100% Oxygen Saturation calibration.
2. Connect the instrument to the computer.
3. Connect the instrument to the software.
4. Go to the **Sensors** tab and select the RDO Sensor.
5. Click the **Calibrate** button.

![Calibration Screen](image)

If you want to restore the factory calibration, select the option and click the **right arrow** button.

6. By default, 100% saturation is selected for the first point of the calibration. If you intend to perform a 2-point calibration, also select 0% saturation from the drop-down list. Otherwise, leave as **None**.
7. Click the **right arrow** button.
8. Enter the barometric pressure or elevation at which the instrument will be deployed.
9. Click the **right arrow** button.
10. Click **OK** to start the calibration.

**Nominal Stability vs. Full Stability**

To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

11. When the screen indicated that the calibration has reached stability, click the **check mark** to complete the calibration, or click **Cancel** to return to the previous calibration.
Calibrate 0% Oxygen Saturation

1. If you selected to perform a 2-point calibration, you are prompted to set up the solution for the second point of the calibration.

2. Remove the wet sponge from the cup.

3. Fill the calibration cup to the fill line with approximately 130 mL of fresh sodium sulfite solution.

4. Completely submerge the RDO Sensor into the solution.

5. Click OK, to start the calibration.

6. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or click Cancel to return to the previous calibration.

7. You can save or print the calibration report.

8. Click OK to complete the calibration.

9. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

Calibrating the pH/ORP Sensor

1. Prepare the instrument for calibration.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the pH/ORP sensor.

5. Click the Calibrate button.

   ![Calibrate button]

   If you want to restore the factory calibration, select the option and click the right arrow button.

6. Select Calibrate pH or Calibrate ORP, and click the right arrow button.
7. Select the appropriate calibration standard from the drop-down list. If you select **User Defined**, enter the value of the solution.

8. Click the **right arrow**.

9. Click **OK** to start the calibration.

### Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or to continue to the next calibration point. Click **Cancel** to return to the previous calibration.

11. You can save or print the calibration report.

12. Click **OK** to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

### Calibrating the Turbidity Sensor

1. Prepare the instrument for calibration.

   - **Warning**: There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the **Sensors** tab and select the Turbidity sensor.
5. Click the **Calibrate** button.

> If you want to restore the factory calibration, select the option and click the **right arrow** button.

6. Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select **User Defined**, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration point 2 if necessary. If you select **User Defined**, enter the value of the solution.

8. Click the **right arrow**.

9. Click **OK** to start the calibration.

**Nominal Stability vs. Full Stability**

To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or to continue to the next calibration point. Click **Cancel** to return to the previous calibration.

11. You can save or print the calibration report.

12. Click **OK** to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

**Calibrating the Ammonium Sensor**

You can perform a one, two or three-point calibration of the ammonium sensor with Win-Situ. For best accuracy, we recommend a two-point calibration in standards closest to the conditions in your testing environment.
Condition the ammonium sensor for a minimum of two hours prior to calibration by soaking it in 140 mg/L ammonium as N standard or the highest standard to be used during calibration. For the best long term results, soak the sensor overnight.

1. Prepare the instrument for calibration.

There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the Ammonium sensor.

5. Click the Calibrate button.

If you want to restore the factory calibration, select the option and click the right arrow button.

6. Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select User Defined, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration point 2. If you select User Defined, enter the value of the solution.

8. Click the right arrow.

9. Click OK to start the calibration.

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

11. You can save or print the calibration report.

12. Click OK to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

Calibrating the Chloride Sensor

You can perform a one, two or three-point calibration of the chloride sensor with Win-Situ. For best accuracy, we recommend a two-point calibration in standards closest to the conditions in your testing environment.

Condition the chloride sensor for a minimum of two hours prior to calibration by soaking it in 355 mg/L chloride standard or the highest standard to be used during calibration. For the best long term results, soak the sensor overnight.
1. Prepare the instrument for calibration.

   ![Warning]
   There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the Chloride sensor.

5. Click the Calibrate button.

   ![Check]
   If you want to restore the factory calibration, select the option and click the right arrow button.

6. Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select User Defined, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration point 2. If you select User Defined, enter the value of the solution.

8. Click the right arrow.

9. Click OK to start the calibration.

   ![Nominal Stability vs. Full Stability]
   Nominal Stability vs. Full Stability
   To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

11. You can save or print the calibration report.

12. Click OK to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

Calibrating the Nitrate Sensor

You can perform a one, two or three-point calibration of the nitrate sensor with Win-Situ. For best accuracy, we recommend a two-point calibration in standards closest to the conditions in your testing environment.

   ![Warning]
   Condition the nitrate sensor for a minimum of two hours prior to calibration by soaking it in 140 mg/L nitrate as N standard or the highest standard to be used during calibration. For the best long term results, soak the sensor overnight.

   ![Warning]
   There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations.

1. Prepare the instrument for calibration.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.
4. Go to the **Sensors** tab and select the Nitrate sensor.

5. Click the **Calibrate** button.

   ![Check] If you want to restore the factory calibration, select the option and click the **right arrow** button.

6. Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select **User Defined**, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration point 2. If you select **User Defined**, enter the value of the solution.

8. Click the **right arrow**.

9. Click **OK** to start the calibration.

   **Nominal Stability vs. Full Stability**
   To meet the criteria for a valid calibration point, the change in sensor response is monitored over time. The software is looking for the calibration solution temperature and the sensor readings to settle over a specific time period. The criteria for Full Stability are designed to meet the published specifications. The criteria for Nominal Stability are designed to shorten the calibration time when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the calibration, or to continue to the next calibration point. Click **Cancel** to return to the previous calibration.

11. You can save or print the calibration report.

12. Click **OK** to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean water.

**Calibration Reports**

   **Saving Calibration Reports**

   At the end of a successful calibration procedure you are prompted to print and/or save the calibration report. If you select to save the report, the Windows save file dialog opens and allows you to complete the action.

   **Viewing Calibration Reports**

   You can view saved calibration reports on the **Data** tab or in your working directory.

   To find the location of your working directory for Win-Situ 5, go to **Preferences** menu > **Working Directory**.

**BaroMerge**

**Using BaroMerge Software**

BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to eliminate barometric pressure effects from the measurements. BaroMerge Software can be accessed through the Win-Situ 5 Software **Tools** menu. BaroMerge provides three options to correct data.

- **Fixed Correction**—A single offset value is applied to all selected log data. Use this option if you know the barometric pressure of the site during the log, and know that it did not change.
- **Manual Entry**—Specify two or more correction values to apply to the log data. Use this option if you wish to manually enter a data set of barometric pressure values.
- **BaroTROLL log file**—Absolute level sensor data points are individually corrected to reflect barometric pressure changes that were logged by a BaroTROLL instrument during the approximate time period.

### Baro Merge Input—Manual Entry

When you select the **Fixed Correction** and **Manual Entry** options, it is important to know the barometric pressure for the general time period covered by the log or logs you want to correct.

1. From the **Tools** menu, select **Win-Situ BaroMerge**.

2. Select the **Enter one or more values manually** option.
3. The compensation table appears that allows you to build a table of barometric data that corresponds to the time the
log was recorded. The compensation table has three preference options:

- The first option, **Save calculated barometric adjustments in the new data file(s)** is the default option. It adds additional columns depending on which parameters were selected for the absolute/non-vented log in the corrected BaroMerge file that uses the compensation table values. This is intended to show how the adjustments were done in the BaroMerge file. If you do not want to show these adjustments, clear this option.

- When the second option, **Show time in UTC** is selected, the compensation table time stamp displays in Coordinated Universal Time (UTC) time, formally known as Greenwich Mean Time (GMT).

- If the third option, **Ignore daylight saving time (DST)** is selected, the compensation table time stamp format without the daylight savings time adjustment will be shown.

3. Build a table that contains at least two barometric pressure values.
4. Click the right arrow and select the absolute (non-vented) log file or files you intend to correct.
5. Click the check mark and the barometric compensation is applied.
6. Compensated data files can be viewed or exported from the Data tab.

**Baro Merge Input—Fixed Correction**

If you select the **Apply a fixed correction** option, a single correction is applied to all values in the log.

To use this correction method you need barometric pressure values from a reliable source. Choose a single value that represents the actual ambient barometric pressure during the time period the log was recorded. You also need to know the file names of the logs you want to correct.
1. From the **Tools** menu, select **Win-Situ Baro Merge**.

![Win-Situ BaroMerge](image)

2. Select the **Apply a fixed correction** option.
3. Enter the barometric correction value and select units from the drop-down menu.
4. Click the **right arrow** button.
5. Select the log files to which the correction will be applied and click the **check mark** button.
6. Compensated data files can be viewed or exported from the **Data** tab.

**BaroMerge Input—BaroTROLL File**

Log files that contain absolute data can be barometrically compensated using values logged by the In-Situ Inc. BaroTROLL Instrument. Select this method when you have access to a BaroTROLL log file covering approximately the same time period as the data file you intend to correct.

To use this correction method, you need the name of the BaroTROLL log file and the name(s) of the absolute log file(s) you want to correct.
1. From the **Tools** menu in Win-Situ 5 Software, select **Win-Situ BaroMerge**.

2. Select the "Use a BaroTROLL file:" option.

3. Click the browse button to the right of the file field.

4. Select a BaroTROLL file and click the **check mark**.

5. Values from the BaroTROLL file will be displayed in the next window. You can edit these values if necessary.

6. Click the **right arrow** button.

7. Select the log file(s) you intend to correct and click the **check mark**.

8. Compensated data files can be viewed or exported from the **Data** tab.

**BaroMerge Output**

Your original log file is not changed. A new, corrected log file with the same name and path is created. The original ".wsl" extension is replaced by "-Baro Merge.wsl".

**Post Level Correction within Baro Merge**

It is also possible to post correct a level reference in data collected from an absolute sensor if the data has been compensated through Baro Merge Software.

1. Follow the steps to compensate the absolute data for barometric pressure.

2. When you reach this screen in the Wizard, you can select the check box to **Post correct files for level**.
Managing Data from Multiple Sites

You can organize and group sites to simplify your data management.

Adding a Site

You can add a new site to the site database in the Win-Situ working directory. After a new site is added, it is available to select as the current site for any instrument.

Editing a Site

You can edit a site to add information that was not available when the site was created, refine a site name (within the 32-character limit), add a site note. If an instrument is connected to the software and it has a running or suspended log, you cannot edit the current site.

1. In the Data tab, select the Site button.
2. Edit site information.
3. Click Save to save the changes.

Deleting a Site

Deleting a site removes it from the site database in your Win-Situ working directory. The site and the data files will be deleted. If the software is connected to an instrument with a running or suspended log the current site cannot be deleted. If while disconnected you inadvertently delete a site that is stored in one of your instruments, Win-Situ will restore it the next time you connect to the instrument.

1. In the Data tab, expand the Site Data folder and right-click the site.
2. Select Delete.

Using Site Groups

Site Groups allow you to organize sites, and therefore data, by customer, region, contract, project, etc. For example, if a project for the XYZ corporation has several different sites where data are logged, you could create a site group called XYZ and drag the appropriate sites into the group on the Data tab.

Creating a Site Group

1. In the Data tab, select the Site Data folder.
2. Click the File menu > New > Site Group.
3. Enter a name for the site group. A site group name can have up to 100 characters.
4. Click Save.

5. The new site group appears in the folder tree with the symbol . The site group does not yet have sites associated with it.

6. To place existing sites into your new site group, select one or more sites in the folder tree, drag and drop them under the new group.

**Site-Based Connections**

Win-Situ allows you to create connection configurations for individual sites. In this way you can easily maintain different communication setups for different sites. The site connection configuration dialog lets you configure and name a connection for the site. When first created, the site connection settings are initialized from the default communication settings (Preferences menu > Comm Settings).

**Creating a Custom Connection**

1. In the Data tab, select the Connections folder.
2. Select File > New > Connection.
3. Enter a name for the new connection.
4. Select the options you want for the new connection.
5. Click Save.

**Using a Custom Connection**

1. Open Win-Situ but do not connect to the instrument.
2. Select the custom connection in the folder tree on the Data tab.
3. Click the Connect button to connect to the instrument using the custom configuration.

**Storing Custom Connection for a Site**

Once a custom connection has been created, it will appear in the Connections area of the Site Information screen and can be selected for use with any site.

**Correcting a Level Reference in Data Files**

**About Post Correcting Level Data**

In specific cases, it is possible to correct a level reference in a data file after you have stopped the log and downloaded the data. The following criteria must be met in order for a level reference to be post corrected in a data file.

- Data must be compensated for barometric pressure before the level reference can be corrected. Therefore, data must come from a vented instrument, or if it is from an absolute instrument, it must be compensated through Baro Merge Software before the level reference can be corrected.

- The data file must already contain a level mode.

- The data file must have been created with Win-Situ version 5.6.0.0 or higher in order to post correct for the Depth reference type.

- The data must have been downloaded with Win-Situ version 5.6.24.4 or higher.

- If the log was originally set to “Zero at start of test” and the user has made changes to the level reference during logging, it is not possible to correct the data with Win-Situ.

Files that have been corrected are stored in a subdirectory named "Post Corrected Files" and "PostLevelCorrection" is added to the file name. The original data file is not altered.
Open Post Level Correction

Post Level Correction can be accessed through Win-Situ 5 Software or through the Baro Merge Software.

1. To open Post Level Correction in Win-Situ 5 Software go to the menu bar and click Tools > Post Level Correction.

2. The software loads the compatible files. Expand the site that contains the data file you intend to correct and select the file.

3. Click the right arrow.

You can also access Post Level Correction in Baro Merge Software. To open Post Level Correction within Baro Merge, check the appropriate check box in the Baro Merge Wizard. See page 116.

Select Level Reference Type

In order to post correct the level reference in a data file, the original data must have been collected in level mode.

1. You can keep the original level reference type, or you can select one of the following reference types.

   - Pressure head (Depth)
   - Depth to water
   - Elevation or gauge height/stage
2. Click the right arrow.

**Set the Level Correction**

1. Select **Set level reference (Reference point set at test definition)** if you want to change the level reference at the time you originally set up the log.

2. Select **Set level reference (Reference at user selected data point)** if you measured your level reference at any point after the start of the test. You must then select the time from which to apply the correction. The level correction will be applied to all data collected after the selected point.

3. Enter the correction value in the **Level reference** field.

4. Click the **right arrow** button.

5. Select a value for specific gravity and click the **right arrow** button.

---

This step is necessary only if the value for specific gravity was set incorrectly in the original file.
6. When post correction is complete, click the check mark button.

View Post Level Corrected Data

1. To view post corrected level data, go to the Data tab.
2. Open the appropriate site in the Site Data folder.
3. Files that have been corrected are stored in a subdirectory (on your hard drive) named "Post Corrected Files" and "PostLevelCorrection" is added to the file name. The original data file was not altered.
4. You can view the data in Win-Situ 5 or export the data to Excel.
   See page 99.

Importing VuSitu Data to Win-Situ

You can import data files from VuSitu into Win-Situ 5 from the File menu.
A. Click **File > Import VuSitu CSV** in the menu bar at the top of the screen.

B. Select the file you wish to import and click **Open**.

C. Select **OK** at the prompt.

D. Click on the file name to view it.

**Win-Situ 5 Troubleshooting**

**Selecting the Correct COM Port**

If you are using a USB TROLL Com, select the correct COM port by following the steps below. If you are using a serial TROLL Com, the Win-Situ Software should default to the correct COM port, which is usually COM 1.

**Steps for Windows 8.1 and Windows 10 systems.**

1. Right-click the **Start** button.
2. Click **Device Manager**.
3. Click the arrow next to **Ports (COM and LPT)**, and locate the USB Serial Port listing. The number listed next to this entry is your COM port address.

**Steps for Windows 8 systems.**

1. Right-click the **Start** screen.
2. Select **All Apps**.
3. Click **Control Panel**.
4. Open the **Device Manager**.
5. Click the arrow next to **Ports (Com and LPT)**, and locate the USB Serial Port listing. The number listed next to this entry is your COM port address.

**Steps for Windows 7 systems.**
1. Click the Start button, and open the Control Panel.
2. Click Hardware and Sound, and open the Device Manager.
3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed next to this entry is your COM port address.

Steps for Windows XP systems.
1. Click the Start button, and open the Control Panel.
2. Double-click the System icon. Click the Hardware tab, and open the Device Manager.
3. Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed next to this entry is your COM port address.

☑️ The following steps apply for all Windows operating systems.

1. Once you have determined the correct COM port address in your operating system, reopen Win-Situ 5 Software.
2. Close any open windows in Win-Situ Software.
3. Click Preferences.
4. Click Comm Settings, and then click the Port Number menu.
5. Scroll down to find the correct COM port address. Click the check mark to accept the changes.
6. Click the yellow Connect button in the lower right corner to establish a connection to the instrument.

Bluetooth Connection
If you are trying to connect via Bluetooth but cannot establish a connection, try the following:

- Locate your Bluetooth settings and ensure Bluetooth is turned on.
- Ensure your computer is paired with the instrument. In your Bluetooth settings you should see the instrument serial number and "Paired."
- Ensure you have selected the correct COM port in Win-Situ 5 Software.
- Ensure you have clicked the connect button in the bottom right corner of the Win-Situ 5 screen.
- Ensure the communication settings for Win-Situ 5 match the device. See "Connecting with Bluetooth" on page 56

Water Quality

pH

What is pH?

The term pH is derived from "p" meaning power and "H" for the element hydrogen and literally means "power of hydrogen." pH is defined as the negative logarithm of the hydrogen ion activity (or concentration in moles/liter):

\[ \text{pH} = -\log [H^+] = 10^{-\text{pH}} \]

Water (H₂O) dissociates into hydrogen ions (H⁺) and hydroxide ions (OH⁻) in aqueous solution. At 25°C there are 1.0 x 10⁻⁷ moles/L of hydrogen ions and 1.0 x 10⁻⁷ moles/L of hydroxide ions in pure water. Thus the water is neutral (pH = 7) because there are equal amounts of each ion. Addition of a substance with hydrogen or hydroxide ions will shift the balance and cause the water to become either acidic or basic.

The pH scale ranges from 0 (most acidic) to 14 (most basic or least acidic). A change of 1 pH unit corresponds to a tenfold change in hydrogen ion concentration.
Why Measure pH?

A pH value indicates the amount of hydrogen ion that is present in an aqueous environment. The hydrogen ion concentration gives an indication of the acidity of a substance. pH is an important measurement in natural waters because most chemical and biochemical processes are pH dependent. The physiological chemistry of most living organisms can tolerate only small changes in pH and still provide the chemical reactions to sustain life. The solubility of many chemicals is pH dependent. Thus, pH determines their availability to living organisms.

<table>
<thead>
<tr>
<th>Fluid</th>
<th>pH units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acid rain</td>
<td>&lt;5</td>
</tr>
<tr>
<td>Distilled water</td>
<td>5.6</td>
</tr>
<tr>
<td>Most neutral waters</td>
<td>8</td>
</tr>
<tr>
<td>Safe for freshwater fish</td>
<td>6-9</td>
</tr>
<tr>
<td>Properly chlorinated swimming pool</td>
<td>7.2 - 7.6</td>
</tr>
</tbody>
</table>

Typical pH values

Natural waters usually have pH values in the range of 4 to 9. Most natural waters are slightly basic (approximately pH 8) because of the presence of carbonates (CO$_3^{2-}$) and bicarbonates (HCO$_3^-$). Extremely fresh water can even be slightly acidic (approximately pH 6), depending on the concentration of dissolved carbon dioxide (CO$_2$). The carbon dioxide combines with water to form a small amount of carbonic acid (H$_2$CO$_3$) and this process lowers the pH. Nitrogen oxides (NO$_x$) and sulfur dioxides (SO$_2$) from automobile exhaust and the burning of coal combine with water in the atmosphere to form nitric (HNO$_3$) and sulfuric acid (H$_2$SO$_4$). This falls to the ground as acid rain and accumulates in surface water. Runoff from mining spoils and the decomposition of plant materials can also cause acidic surface water.

pH values below 5 in natural waters are generally considered to be too acidic for most aquatic organisms. Freshwater fish survive best in the pH range of 6 to 9. Acidic drinking water is a concern due to its corrosive characteristics to plumbing and appliances. pH affects the ammonia/ammonium (NH$_3$/NH$_4^+$) equilibrium in water. Even a small amount of ammonia is detrimental to fish while a moderate amount of ammonium is tolerated. At a pH of 6.5 almost all ammonia is in the form of ammonium. However, as the pH becomes slightly basic, ammonium is changed into harmful ammonia. The lethal dose of ammonia for trout is only 0.2 mg/L.

The pH/ORP Sensor

The single-junction, three-electrode sensor uses a potentiometric method to measure the pH of a solution. The sensor consists of a pH-sensitive glass whose voltage is proportional to the hydrogen ion concentration. The ORP electrode serves as an electron donor or acceptor depending upon the solution. A second sensor (electrode) serves as a reference, which supplies a constant stable output. Electrical contact is made with the solution using a saturated potassium chloride (KCl) solution. The electrode behavior is described by the Nerst equation:

$$E_m = E_o + (2.3RT/nF) \log [H^+]$$

where

$E_m$ is the potential from the pH electrode,
$E_o$ is related to the potential of the reference electrode,
$R$ is the Gas Law constant,
$F$ is Faraday’s constant,
$T$ is the temperature in Kelvin,
$n$ is the ionic charge (+1 for Hydrogen), and
$[H^+]$ is the hydrogen ion concentration in moles/L.

The instrument reads the signal from the pH electrode, the reference electrode, and the temperature and then calculates the pH using the Nerst equation.
Oxidation-Reduction Potential

What is ORP?

Oxidation-Reduction Potential (ORP) is a measure of a water system's capacity to either release or gain electrons in chemical reactions. The process of oxidation involves losing electrons while reduction involves gaining electrons. Oxidation and reduction (redox) reactions control the behavior of many chemical constituents in drinking water, waste water, and aquatic environments. The reactivity and solubility of critical elements in living systems is strongly dependent on redox conditions. ORP values are used much like pH values to determine water quality. While pH values characterize the relative state of a system for receiving or donating hydrogen ions (acting as a base or an acid), ORP values are affected by all oxidizing and reducing agents, not just acids and bases.

Why Measure ORP?

The effect that potable water has on plumbing is directly related to its ORP value. Unfavorable values can cause excessive corrosion, leading to expensive repairs. ORP is one parameter that can be monitored during the disinfecting process for drinking water, swimming pool water, and spa water.

The life expectancy of bacteria in water is related to ORP. In fact, studies have shown that the life span of bacteria in water is more dependent on the ORP value than on the chlorine concentration. For swimming pools at a normal pH value between 7.2 and 7.6, the ORP value must be kept above 700 mV to kill unwanted organisms. Hypochlorite or other oxidizing agents must be added when the ORP falls below 700 mV. In contrast, natural waters need a much lower ORP value in order to support life.

<table>
<thead>
<tr>
<th>Fluid</th>
<th>ORP (mV)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salt water aquarium</td>
<td>~ 350</td>
</tr>
<tr>
<td>Harmful to aquatic life</td>
<td>&gt; 400</td>
</tr>
<tr>
<td>Properly chlorinated swimming pool</td>
<td>&gt; 700</td>
</tr>
</tbody>
</table>

Generally ORP values above 400 mV are harmful to aquatic life. Ideally the ORP value in salt water aquariums should be kept between 350 and 390 mV. ORP levels below 300 mV are to be avoided. An oxidizing environment is needed to convert any ammonia (NH₃) to nitrites (NO₂⁻) and nitrates (NO₃⁻). Ammonia levels as low as 0.002 mg/L can be harmful to some fish species.

The determination of ORP is particularly worthwhile in water that contains a relatively high concentration of a redox-active species, e.g., the salts of many metals (Fe²⁺, Fe³⁺) and strong oxidizing (chlorine) and reducing (sulfite) agents. Thus, ORP can sometimes be utilized to track the metallic pollution of ground- or surface water, or to determine the chlorine content of wastewater effluent. However, ORP is a nonspecific measurement—that is, the measured potential is reflective of a combination of the effects of all the dissolved species in the medium. Because of this factor, the measurement of ORP in relatively clean environmental water (ground, surface, estuarine, and marine) has only limited utility unless a predominant redox-active species is known to be present. Care is required not to "over-interpret" ORP data unless specific information about the site is known.

The pH/ORP Sensor

The single-junction, three-electrode sensor uses a potentiometric method to measure the ORP of a solution. The sensor consists of a pH-sensitive glass whose voltage is proportional to the hydrogen ion concentration. The ORP electrode serves as an electron donor or acceptor depending upon the solution. A second sensor (electrode) serves as a reference, which supplies a constant stable output. Electrical contact is made with the solution using a saturated potassium chloride (KCl) solution. The electrode behavior is described by the Nerst equation:

\[ E_m = E_o - (RT/nF) \ln ([\text{ox}] / [\text{red}]) \]
where

\[ E_m \] is the potential from the ORP electrode,
\[ E_0 \] is related to the potential of the reference electrode,
\( R \) is the Gas Law constant,
\( F \) is Faraday's constant,
\( T \) is the temperature in Kelvin,
\( n \) is the number of electrons,
\([\text{ox}]\) is the oxidant concentration in moles/L, and
\([\text{red}]\) is the reduction concentration in moles/L.

Most natural waters contain many species that are involved in the redox process so that it is not possible to calculate the ORP using the Nerst equation. All redox species do however reach equilibrium. A Standard solution of known redox potential for a particular ORP electrode is used to calibrate ORP. The sensor then gives a calibrated response in mV when placed in a sample.

**Conductivity**

**What is Conductivity?**

Electrical conductivity measures the ability of a material to carry an electric current. Lakes, rivers, oceans, and underground aquifers are typically good conductors because they contain dissolved salts and minerals. These salts and minerals dissociate in the presence of water to form negatively and positively charged particles called anions and cations. Anions and cations provide a pathway for the transportation of electrical chargers throughout the aqueous medium. For the most part, the higher the concentration of dissolved salts and minerals in water, the better the conductor and the higher the electrical conductivity. Deionized/distilled water is a poor conductor because almost all anions and cations are removed during the deionization/distillation process.

**Why Measure Conductivity?**

Changes in the conductivity of a body of water are often used to indicate an environmental event. For example, a drastic increase in the electrical conductivity of an underground fresh water aquifer located near the ocean could indicate the beginning of salt water intrusion. Contrarily, an increase in the electrical conductivity of a small lake that is completely surrounded by farmland may simply be the result of runoff from a recent rain.

**How is Conductivity Measured?**

Conductance is the reciprocal of the resistance, in ohms, measured between two opposing electrodes of a 1 cm cube at a specific temperature. The unit 1/ohm or mho was given the name of Siemens (S) for conductance. It is not practical to require all conductance cells to have the dimensions of a exact cube. To enable the comparison of data from experiments with different conductance cells, the conductance is multiplied be the cell constant to give conductivity in Siemens per centimeter (S/cm). Cell constants are determined for each sensor using a standard solution of known conductivity. The cell constant depends on the electrode area and the amount of separation or distance between the electrodes.

<table>
<thead>
<tr>
<th>Fluid</th>
<th>Conductivity Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ultra-pure distilled water</td>
<td>0.05 µS/cm</td>
</tr>
<tr>
<td>Distilled water</td>
<td>1.0 µS/cm</td>
</tr>
<tr>
<td>Drinking water</td>
<td>50 to 300 µS/cm</td>
</tr>
<tr>
<td>Surface water</td>
<td>100 to 10,000 µS/cm</td>
</tr>
</tbody>
</table>
### Conductivity Values

<table>
<thead>
<tr>
<th>Fluid</th>
<th>Conductivity Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sea water</td>
<td>40,000 to 55,000 µS/cm</td>
</tr>
<tr>
<td>Great Salt Lake</td>
<td>158,000 µS/cm</td>
</tr>
</tbody>
</table>

Early conductivity measurements were performed using cells with two electrodes. This method required using three conductivity cells with different cell constraints in order to span the range of 1 to 100,000 microSiemens per centimeter (µS/cm). Another inconvenience occurred when deposits formed on electrodes, thus reducing the measured conductivity of the sample.

The modern four-electrode conductivity cell offers many advantages over the two-electrode method. It contains two drive electrodes and two sensing electrodes. The sensing electrodes are positioned in a low current area so that electrode fouling is minimized. An alternating current is used to drive the cell. This reduces errors caused by polarization resulting from the application of direct current.

### Dissolved Oxygen

#### What is Dissolved Oxygen?

The amount of dissolved oxygen (DO) in both natural water and wastewater is a function of several parameters. DO is highly dependent on temperature and atmospheric pressure. An increase in temperature causes a decrease in the amount of oxygen that can dissolve in water. Conversely, higher atmospheric pressures result in higher DO values. Salinity is also a factor. Oxygen solubility is greater in freshwater than in salt water. There are also chemical and biochemical processes that affect DO.

Most of the dissolved oxygen in water comes from the atmosphere, but oxygen from the photosynthesis of aquatic plants is also a key source. DO levels in lakes and other surface water will actually follow a cyclic or diurnal pattern over the course of a day, rising and falling as light intensity changes from dawn to dusk.

#### Why Measure DO?

Most aquatic life requires an average DO value greater than 5.0 milligrams dissolved oxygen per liter of water (mg/L) in order to survive. Although the amount of dissolved oxygen in a body of water fluctuates due to natural processes, large deviations from normal levels are usually a result of human activity. Changes in DO levels are usually the result of a buildup in organic waste. Organic waste can enter surface water from treatment facilities, runoff from agricultural feed lots or domestic areas, and from industrial discharge. Organic wastes often contain nitrates and phosphates. Nitrates and phosphates are nutrients for aquatic plants and algae, stimulating overproduction when present in excessive levels. Accelerated growth of blooms increase the number of photosynthesizing plants, which temporarily increases the amount of dissolved oxygen. However, submerged aquatic vegetation eventually experience a reduction in sunlight due to increased coverage on the surface. This decrease in sunlight leads to a reduction in photosynthesis and eventual death. Bacterial processes take over and consume even more dissolved oxygen. Fish and other aquatic species die due to lack of dissolved oxygen. This tragic process is known as eutrophication.

<table>
<thead>
<tr>
<th>Conditions</th>
<th>DO Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>100% DO, 0°C, 1 atm, 0 ppm Chlorine*</td>
<td>14.6 mg/L</td>
</tr>
<tr>
<td>100% DO, 20°C, 1 atm, 0 ppm Chlorine</td>
<td>9.09 mg/L</td>
</tr>
<tr>
<td>100% DO, 0°C, 0.75 atm, 0 ppm Chlorine</td>
<td>6.77 mg/L</td>
</tr>
</tbody>
</table>
### Conditions

<table>
<thead>
<tr>
<th>Conditions</th>
<th>DO Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>100% DO, 20°C, 1 atm, 20 ppm Chlorine</td>
<td>7.35 mg/L</td>
</tr>
<tr>
<td>Safe level for most aquatic life</td>
<td>&gt; 5.0 mg/L</td>
</tr>
</tbody>
</table>

### How is DO Measured?

Traditional methods for DO determination include the Winkler titration method and electrochemical methods, such as polarographic (Clark cell) and galvanic probes. With electrochemical methods, molecular oxygen is consumed by an electrochemical process. Two dissimilar metal electrodes (anode and cathode) are in contact with an electrolyte solution. A semi-permeable membrane separates the electrodes from the sample. As oxygen molecules diffuse through the semipermeable membrane, they are reduced at the cathode to form positively charged ions. The ions migrate to the anode where an oxidation reaction occurs. The oxidation/reduction reaction generates an electrical current that is directly proportional to the oxygen concentration.

Optical sensor technology takes a different approach to quantifying DO. Originally introduced in the 1970s, recent developments have allowed for the production of cost-effective probes that operate in demanding environments. The RDO optical dissolved oxygen sensor measures dissolved oxygen using the principle of "dynamic luminescence quenching." Certain molecules, called "lumiphores," fluoresce when excited by light of a specific wavelength. Oxygen molecules act to quench this fluorescence. The lumiphores in the sensor are embedded in a gas-permeable sensing foil in a replaceable cap.

The sensor optics include a lens, blue LED and filter, red LED and filter, and a photodetector. When the blue LED emits light, the sensing foil emits red photons; the presence of oxygen in the foil causes a reduction in red light detected by the photodiode. The phase difference between the blue excitation light and the returned red light is measured, and the result is used to compute dissolved oxygen.

This method measures the phase shift (or delay) of the returned signal, and is thus based on the "lifetime" rather than the "intensity" of the luminescence.

### Turbidity

**What is Turbidity?**

Turbidity is an indirect measure of the clarity or transparency of water, and thus is an important indicator of its condition and productivity. Created by suspended matter and microscopic organisms, turbidity causes light to be scattered and absorbed rather than transmitted directly through water. Turbidity is the physical characteristic of the solution that causes light scattering. Turbidity is the opposite of clarity.

The American Public Health Association (APHA) reference word *Standard Methods* (Eaton and others, 2005) defines turbidity as "an expression of the optical property that causes light to be scattered and absorbed rather than transmitted with no change in direction or flux level through the sample."

**Turbidity is not:**

- a direct measure of clarity.
- a measure of color.
- a measure of suspended solids; it is a measure of their light scattering abilities.

**Why Measure Turbidity?**

Turbidity measurements:

- can provide a reasonable estimate of the total suspended solids or sediments (TSS) concentration in water.
- can tell us something about the health of a natural water body. Clear water lets light penetrate more deeply into a lake or stream than does murky water. This light allows photosynthesis to occur and oxygen to be produced.
- can be a useful indicator of runoff into surface water systems.
in flow-cell or in-line applications, when pumping water at very low rates, can provide a good indication of true formation water.

Typical Turbidity values

<table>
<thead>
<tr>
<th>Fluid</th>
<th>Turbidity Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPA drinking water</td>
<td>0.3 to 0.5 NTU</td>
</tr>
<tr>
<td>Treated water</td>
<td>0 to 1 NTU</td>
</tr>
<tr>
<td>Fresh water, &gt;21.5 in. visibility</td>
<td>&lt; 10 NTU</td>
</tr>
<tr>
<td>Fresh water, 2.5 in. visibility</td>
<td>240 NTU</td>
</tr>
<tr>
<td>Short-term stress to aquatic life</td>
<td>&gt; 10 NTU</td>
</tr>
<tr>
<td>Unsafe level for most aquatic life</td>
<td>&gt;100 NTU</td>
</tr>
</tbody>
</table>

Higher turbidity levels can make it more costly to treat surface water for use as drinking water. Controlling turbidity may be an effective way to protect against pathogens in drinking water.

Aesthetic considerations also play a role in our desire to quantify turbidity: Most people would rather look at, drink, or swim in clear water than in water that appears cloudy, and closely associate appearance with the health of the body of water.

How is Turbidity Measured?

Historical methods for measuring turbidity relied on subjective estimates that depended largely on the eye of the beholder.

In the Jackson Candle method, for example, a candle flame is observed through the length of a glass tube into which a fluid sample is poured until the rays of transmitted and scattered light appear equal and the flame essentially disappears. Among several drawbacks to this method, the reproducibility of standards formulated from natural sediments was difficult to control.

The Secchi disk method used in limnological studies involves submerging a weighted, black-and-white painted metal plate until the pattern can no longer be detected. The plate is then pulled up until it is visible again. The average of the two depths provides an estimate of water clarity or transparency.

Modern turbidimeters measure the loss in intensity of a beam or a light beam as it passes through a solution containing suspended and dissolved particles that are large enough to scatter the light. The method is based upon a comparison of the intensity of light scattered by the sample with the intensity of light scattered by a standard reference suspension. The nephelometer is a particular type of turbidimeter that measures the intensity of light scattered at right angles (90°) to the incident light. This lessens the difficulty of differentiating small changes against a large background. Standards for turbidity-measurement instruments specify the light source, angle, wavelength, beam width, and sample suspensions, among other factors. Many of today's commonly accepted procedures (e.g., Standard Methods, EPA, and ISO) apply to laboratory bench-top instruments.
Care and Maintenance

Maintenance Schedule

For best results, send the instrument to the manufacturer for factory calibration every 12 to 18 months.

User-Serviceable Parts

The user-serviceable parts on the instrument include the O-rings, the RDO, pH/ORP, conductivity, temperature, and turbidity sensors, and the RDO Sensor Cap.

O-rings

The instrument has several O-rings that can be maintained by the user in order to keep moisture from entering the instrument and damaging the electronics. Apply a very thin layer of vacuum grease to new O-rings upon installation. Check O-rings for cracks, chips, or discoloration and change when any of these conditions appear.

pH/ORP Sensor Replacement

To replace the pH/ORP sensor or to refill the reference junction, follow the instructions in the pH/ORP Sensor Instruction Sheet that is included with the replacement sensor.

RDO Sensor Cap Replacement

The RDO Sensor Cap has a 2-year typical life. Follow the instructions included in the RDO Sensor Cap Replacement Kit. Replacement caps are available from In-Situ Inc. or your authorized In-Situ distributor.

Instrument Storage

Short-term Storage (<1 Week)

The restrictor can be used as a storage cup.
1. Remove the restrictor from the sonde body.
2. Remove the blue end cap from the restrictor.
3. Screw the blue end cap on to the restrictor end opposite of the flow-through holes.
4. Pour 15 mL (5 oz) of clean water into the restrictor.
5. Screw the restrictor on to the sonde.

Long-term Storage (>1 Week)

1. Remove the pH/ORP sensor and place a sensor port plug into the empty pH/ORP port.
2. Add a small amount of pH Storage Solution (0065370) or pH 7 calibration solution (0083210) to the sponge in the pH/ORP storage cap.
3. Place the cap firmly on the sensor. Use electrical tape to seal the cap to the sensor.

Electrical tape prevents the sponge from drying out and keeps crystals from forming on the sensor body.
4. Place a dust cap on the sensor connector.
5. Remove the batteries from the sonde.
6. Remove the restrictor from the sonde body.
7. Remove the blue end cap from the restrictor.
8. Screw the blue end cap on to the restrictor end opposite of the flow-through holes.
9. Screw the restrictor on to the sonde.
10. Place a dust cap on the sensor connector.
11. Store the sonde and pH/ORP sensor in the box they arrived, at temperatures between -5° to 65° C.

Cleaning the Sonde

Rinse the sonde thoroughly, clean with warm water and mild soap, then rinse the sonde again. Allow to air dry.

⚠️ Prevent water from entering the cable connector.

Cleaning and Storing the pH/ORP Sensor

Routine Maintenance

If the ORP platinum electrode is dull or dirty, it can be cleaned with a swab and methanol or isopropyl alcohol. Rub the electrode gently until it is shiny.

The pH sensor must be kept moist for the life of the sensor.

The sensor fill solution has a shelf life of 2 years. Replace the fill solution every 5 to 6 months or when:

- The sensor fails to calibrate within the acceptable slope and offset range.
- Sensor readings vary.
- Readings during calibration at pH 7 are greater than +30 mV or less than -30 mV.
- Sensor is slow to respond.

✔️ If the sensor fails to calibrate after you replace the fill solution, replace the reference junction.

Replacing the Filling Solution

1. Remove the sensor from the port.
   - Aqua TROLL 500/600—Loosen the screw at the bottom of the sensor. Insert the tool into the small hole and lever the sensor out of the sonde.
2. Install the dust cap on the connector end or wrap the connector end in a paper towel to prevent solution from entering the connector.
3. Unscrew the reference junction.
4. Hold the sensor at an angle and empty the old filling solution into a paper towel or trash can.
5. Lightly shake the bottle of reference filling solution to mix. Turn the bottle upside down until fluid begins to drip from the fill tube. This will eliminate air bubbles in the solution.
6. Insert the fill tube into the bottom of the empty reservoir. Squeeze a steady stream of solution into the reservoir while slowly pulling the tube out. Overfill slightly, then reinsert the tube and pull back out to ensure no air bubbles are trapped.
7. Attach the reference junction cap to the sensor and tighten until it touches the sensor body. Turn the cap 90° more (one quarter of a turn). Some filling solution will overflow. Wipe the excess off the sensor body.
8. Soak the sensor in tap water for at least 15 minutes.
9. Calibrate the sensor.

If necessary, thoroughly clean the sensor connector to remove filling solution: Using a disposable pipette, fill the connector with isopropyl alcohol (70% to 100%), shake to dry. Repeat 3 times. Dry overnight. When thoroughly dry, calibrate the sensor.

Replacing the Junction

Replace the junction when the sensor fails to calibrate with a reasonable slope and offset, even after you have replaced the filling solution.

1. Unscrew the reference junction and discard.
2. Replace the filling solution and screw in a new reference junction.
3. Soak for 15 minutes, then calibrate the sensor.

Keep the junction damp at all times to avoid a lengthy rewetting process.

Cleaning

Begin with the most gentle cleaning method and continue to the other methods only if necessary. Do not directly wipe the glass bulb.

To clean the pH sensor, gently rinse with cold water. If further cleaning is required, consider the nature of the debris.

To remove crystalline deposits:

- Clean the sensor with warm water and mild soap.
- Soak the sensor in 5% HCl solution for 10 to 30 minutes.
- If deposits persist, alternate soaking in 5% HCl and 5% NaOH solutions.

To remove oily or greasy residue:

- Clean the sensor with warm water and mild soap.
- Methanol or isopropyl alcohol may be used for short soaking periods, up to 1 hour.
- Do not soak the sensor in strong solvents, such as chlorinated solvents, ethers, or ketones, such as acetone.

To remove protein-like material, or slimy film:

- Clean the sensor with warm water and mild soap.
- Soak the sensor in 0.1 M HCl solution for 10 minutes and then rinse with deionized water.

After performing any of these cleaning methods, rinse the sensor with water, then soak overnight in pH 4 buffer.

Short-term Storage

Up to 1 week: Soak the sponge included with the black storage cap with pH 4 buffer and install the cap on to the sensor. Use electrical tape to seal the cap onto the sensor to prevent leaks or the sponge drying out.
Long-term Storage

Greater than 1 week: Soak the sponge included with the black storage cap with storage solution (0065370) and install the cap on to the sensor. Use electrical tape to seal the cap onto the sensor to prevent leaks or the sponge drying out.

Storage Recommendations

Prior to using the pH sensor after long-term storage, rinse the sensor with DI water and then soak it in pH 4 buffer for 1 or 2 hours. This will saturate the glass bulb with hydrogen ions and prepare it for use.

> Do not store the pH sensor in DI water because it will deplete the reference solution and drastically reduce the life of the sensor.

Cleaning and Storing the RDO Sensor

Routine Maintenance

1. Leave the sensor cap on.
2. Rinse the sensor with clean water.
3. Gently wipe with a soft cloth or brush if biofouling is present.
4. If extensive fouling or mineral buildup is present, soak the sensor in vinegar for 15 minutes, then soak in deionized water for 15 minutes.

> Do not use organic solvents—they will damage the sensor cap. Do not remove the sensor cap when rinsing or brushing.

5. After cleaning the sensor, perform a 2-point calibration.

Cleaning the Optical Window

Clean the optical window only when changing the sensor cap.

1. Remove the cap.
2. Gently wipe the sensing window with the supplied lens cloth.

> Do not wet the lens with any liquid.

Storage

Prior to installation, store the sensor body and cap in the factory supplied containers.

Once installed on the sonde, the RDO sensor can be stored wet or dry depending on the sensor configuration of the sonde.
Cleaning and Storing the Conductivity Sensor

Cleaning

Begin with the most gentle cleaning method and continue to the other methods only if necessary.

To clean the conductivity sensor face, gently rinse with clean, cold water. If further cleaning is required, consider the nature of the debris.

To remove crystalline deposits:
- Clean the sensor face with warm water and mild soap.
- Use a soft brush to gently clean the sensor pins and temperature button. Ensure removal of all debris around the base of the pins and button.
- If crystalline deposits persist, soak in 5% HCl for 10 to 30 minutes followed by warm soapy water and soft brushing.
- If deposits persist, alternate soaking in 5% HCl and 5% NaOH solutions followed by warm soapy water and soft brushing.

To remove oily or greasy residue:
- Clean the sensor face with warm water and mild soap.
- Using a soft brush, gently clean the sensor pins and temperature button. Ensure removal of all residue around the base of the pins and temperature button.
- Isopropyl alcohol may be used for short soaking periods, up to one hour.
- Do not soak in strong solvents such as chlorinated solvents, ethers or ketones (such as acetone).

To remove protein-like material, or slimy film:
- Clean the sensor face with warm water and mild soap.
- Using a soft brush, gently clean the sensor pins and temperature button. Ensure removal of all material/film around the base of the pins and temperature button.
- Soak the sensor in 0.10% HCl for 10 minutes and then rinse thoroughly with distilled water.

Storage

Prior to installation, store the sensor in the factory supplied container.

Once installed on the sonde, the Temperature Sensor and Conductivity Sensor can be stored wet or dry depending on the sensor configuration of the sonde. For the best accuracy over instrument life, keep the conductivity cell submersed in water for 24-48 hours prior to calibration and deployment.

Cleaning and Storing the Turbidity Sensor

Routine Maintenance

The optical windows should be clear of foreign material. To clear material gently rub the sensing windows using clean water and a soft cloth or swab. Do not use solvents on the sensor.

Storage

Prior to installation, store the sensor in the factory supplied container.
Once installed on the sonde, the turbidity sensor can be stored wet or dry depending on the sensor configuration of the sonde.

**Replacing Wiper Bristles**

Wiper bristles need to be replaced based on site conditions. In-Situ recommends replacing bristles at least every 12 months or when visibly bent, damaged, or fouled.

**Replace the Bristles**

1. Slide both bristle sets out of the wiper head.
2. Insert new small bristle set into the small slot and the large bristle set in the large slot.

**Replace the Entire Brush**

1. Loosen the set screw near the base of the wiper head.
2. Slide the wiper head off the wiper shaft.
3. Slide the wipe head on to the wiper shaft, and position the wiper head so the set screw faces the flat part of the wiper shaft.
4. Tighten the set screw near the base of the wiper head.

**Cleaning the Copper Antifouling Restrictor**

When copper is deployed in environmental waters, particularly marine environments, the copper will oxidize and its biocidal properties decrease. Cleaning the copper restores the effectiveness of the restrictor’s antifouling capability.

1. Remove the restrictor from the sonde.
2. Remove the restrictor end cap.
3. Submerge the restrictor in white vinegar (acetic acid) for 24 hours.
4. Rinse the restrictor in water and air dry.
Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Aqua TROLL® 600 Multiparameter Sonde
Model: Aqua TROLL® 600
Product Description: Multiparameter water quality data logger

is in compliance with the following Directive


and meets or exceeds the following international requirements and compliance standards:

- **Immunity**
  EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use, Industrial Location

- **Emissions**
  Class A requirements of EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 2004/108/EC and 2006/95/EC, and the CE mark is affixed accordingly.

Ben Kimbell
VP of R&D
In-Situ, Inc.
August 25, 2015

RoHS  

FCC (SSSBC127-X)
# Appendix

## Appendix A: Parameter Discovery

The first register read in a PLC measurement sequence should be a 14-register block beginning with register number 6984. A read of these registers triggers the sonde to scan its sensor ports and update its sensor map. This guarantees that the sonde has properly registered any changes to the sensor configuration a user may have made since the last measurement sequence. The bitwise contents of these registers indicate which parameter IDs (1 to 219) are currently available from the sonde according to the table below. Refer to Appendix B for a description of parameter IDs.

<table>
<thead>
<tr>
<th>Register</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>15</td>
</tr>
<tr>
<td>6984</td>
<td>16</td>
</tr>
<tr>
<td>6985</td>
<td>32</td>
</tr>
<tr>
<td>6986</td>
<td>48</td>
</tr>
<tr>
<td>6987</td>
<td>64</td>
</tr>
<tr>
<td>6988</td>
<td>80</td>
</tr>
<tr>
<td>6989</td>
<td>96</td>
</tr>
<tr>
<td>6990</td>
<td>112</td>
</tr>
<tr>
<td>6991</td>
<td>128</td>
</tr>
<tr>
<td>6992</td>
<td>144</td>
</tr>
<tr>
<td>6993</td>
<td>160</td>
</tr>
<tr>
<td>6994</td>
<td>176</td>
</tr>
<tr>
<td>6995</td>
<td>192</td>
</tr>
<tr>
<td>6996</td>
<td>208</td>
</tr>
<tr>
<td>6997</td>
<td>0</td>
</tr>
</tbody>
</table>

## Appendix B – Parameter Numbers and Locations

<table>
<thead>
<tr>
<th>Id</th>
<th>Parameter Name</th>
<th>Holding Register Number</th>
<th>Holding Register Address</th>
<th>Default Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Temperature</td>
<td>5451</td>
<td>5450</td>
<td>1 °C</td>
</tr>
<tr>
<td>2</td>
<td>Pressure</td>
<td>5458</td>
<td>5457</td>
<td>17 PSI</td>
</tr>
<tr>
<td>3</td>
<td>Depth</td>
<td>5465</td>
<td>5464</td>
<td>38 feet</td>
</tr>
<tr>
<td>4</td>
<td>Level, Depth to Water</td>
<td>5472</td>
<td>5471</td>
<td>38 feet</td>
</tr>
<tr>
<td>5</td>
<td>Level, Surface Elevation</td>
<td>5479</td>
<td>5478</td>
<td>38 feet</td>
</tr>
<tr>
<td>9</td>
<td>Actual Conductivity</td>
<td>5507</td>
<td>5506</td>
<td>65 uS/cm</td>
</tr>
<tr>
<td>10</td>
<td>Specific Conductivity</td>
<td>5514</td>
<td>5513</td>
<td>65 uS/cm</td>
</tr>
<tr>
<td>11</td>
<td>Resistivity</td>
<td>5521</td>
<td>5520</td>
<td>81 ohm-cm</td>
</tr>
<tr>
<td>12</td>
<td>Salinity</td>
<td>5528</td>
<td>5527</td>
<td>97 PSU</td>
</tr>
<tr>
<td>Id</td>
<td>Parameter Name</td>
<td>Holding Register Number</td>
<td>Holding Register Address</td>
<td>Default Units</td>
</tr>
<tr>
<td>----</td>
<td>-----------------------------------------------------</td>
<td>-------------------------</td>
<td>--------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>13</td>
<td>Total Dissolved Solids</td>
<td>5535</td>
<td>5534</td>
<td>114 = ppt</td>
</tr>
<tr>
<td>14</td>
<td>Density of Water</td>
<td>5542</td>
<td>5541</td>
<td>129 = g/cm³</td>
</tr>
<tr>
<td>16</td>
<td>Barometric Pressure</td>
<td>5556</td>
<td>5555</td>
<td>22 = mmHg</td>
</tr>
<tr>
<td>17</td>
<td>pH</td>
<td>5563</td>
<td>5562</td>
<td>145 = pH</td>
</tr>
<tr>
<td>18</td>
<td>pH mV</td>
<td>5570</td>
<td>5569</td>
<td>162 = mV</td>
</tr>
<tr>
<td>19</td>
<td>ORP</td>
<td>5577</td>
<td>5576</td>
<td>162 = mV</td>
</tr>
<tr>
<td>20</td>
<td>Dissolved Oxygen concentration</td>
<td>5584</td>
<td>5583</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>21</td>
<td>Dissolved Oxygen % saturation</td>
<td>5591</td>
<td>5590</td>
<td>177 = % Saturation</td>
</tr>
<tr>
<td>24</td>
<td>Chloride (Cl-)</td>
<td>5612</td>
<td>5611</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>25</td>
<td>Turbidity</td>
<td>5619</td>
<td>5618</td>
<td>194 = NTU</td>
</tr>
<tr>
<td>30</td>
<td>Oxygen Partial Pressure</td>
<td>5654</td>
<td>5653</td>
<td>26 = torr</td>
</tr>
<tr>
<td>31</td>
<td>Total Suspended Solids</td>
<td>5661</td>
<td>5660</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>32</td>
<td>External Voltage</td>
<td>5668</td>
<td>5667</td>
<td>163 = Volts</td>
</tr>
<tr>
<td>33</td>
<td>Battery Capacity (remaining)</td>
<td>5675</td>
<td>5674</td>
<td>241 = %</td>
</tr>
<tr>
<td>34</td>
<td>Rhodamine WT Concentration</td>
<td>5682</td>
<td>5681</td>
<td>118 = µg/L</td>
</tr>
<tr>
<td>35</td>
<td>Rhodamine WT Fluorescence Intensity</td>
<td>5689</td>
<td>5688</td>
<td>257 = RFU</td>
</tr>
<tr>
<td>36</td>
<td>Chloride (Cl-) mV</td>
<td>5696</td>
<td>5695</td>
<td>162 = mV</td>
</tr>
<tr>
<td>37</td>
<td>Nitrate as Nitrogen (NO3--N) concentration</td>
<td>5703</td>
<td>5702</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>38</td>
<td>Nitrate (NO3-) mV</td>
<td>5710</td>
<td>5709</td>
<td>162 = mV</td>
</tr>
<tr>
<td>39</td>
<td>Ammonium as Nitrogen (NH4+-N) concentration</td>
<td>5717</td>
<td>5716</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>40</td>
<td>Ammonium (NH4) mV</td>
<td>5724</td>
<td>5723</td>
<td>162 = mV</td>
</tr>
<tr>
<td>41</td>
<td>Ammonia as Nitrogen (NH3-N) concentration</td>
<td>5731</td>
<td>5730</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>42</td>
<td>Total Ammonia as Nitrogen (NH3-N) concentration</td>
<td>5738</td>
<td>5737</td>
<td>117 = mg/L</td>
</tr>
<tr>
<td>48</td>
<td>Eh</td>
<td>5780</td>
<td>5779</td>
<td>162 = mV</td>
</tr>
<tr>
<td>49</td>
<td>Velocity</td>
<td>5787</td>
<td>5786</td>
<td>118 = µg/L</td>
</tr>
<tr>
<td>50</td>
<td>Chlorophyll-a Concentration</td>
<td>5794</td>
<td>5793</td>
<td>118 = µg/L</td>
</tr>
<tr>
<td>51</td>
<td>Chlorophyll-a Fluorescence Intensity</td>
<td>5801</td>
<td>5800</td>
<td>257 = RFU</td>
</tr>
<tr>
<td>54</td>
<td>Blue Green Algae-Phycocyanin Concentration</td>
<td>5822</td>
<td>5821</td>
<td>118 = µg/L</td>
</tr>
<tr>
<td>55</td>
<td>Blue Green Algae-Phycocyanin Fluorescence Intensity</td>
<td>5829</td>
<td>5828</td>
<td>257 = RFU</td>
</tr>
<tr>
<td>58</td>
<td>Blue Green Algae-Phycocerythrin Concentration</td>
<td>5850</td>
<td>5849</td>
<td>118 = µg/L</td>
</tr>
<tr>
<td>59</td>
<td>Blue Green Algae-Phycocerythrin Fluorescence Intensity</td>
<td>5857</td>
<td>5856</td>
<td>257 = RFU</td>
</tr>
</tbody>
</table>

**Appendix C: Unit Ids**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Temperature (1-16)</strong></td>
</tr>
<tr>
<td>1</td>
<td>C</td>
<td>Celsius</td>
</tr>
<tr>
<td>2</td>
<td>F</td>
<td>Fahrenheit</td>
</tr>
<tr>
<td>3</td>
<td>K</td>
<td>Kelvin</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Pressure, Barometric Pressure (17-32)</strong></td>
</tr>
<tr>
<td>17</td>
<td>PSI</td>
<td>Pounds per square inch</td>
</tr>
<tr>
<td>Id</td>
<td>Abbreviation</td>
<td>Units</td>
</tr>
<tr>
<td>----</td>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>18</td>
<td>Pa</td>
<td>Pascals</td>
</tr>
<tr>
<td>19</td>
<td>kPa</td>
<td>Kilopascals</td>
</tr>
<tr>
<td>20</td>
<td>Bar</td>
<td>bars</td>
</tr>
<tr>
<td>21</td>
<td>mBar</td>
<td>millibars</td>
</tr>
<tr>
<td>22</td>
<td>mmHg</td>
<td>Millimeters of Mercury (0°C)</td>
</tr>
<tr>
<td>23</td>
<td>inHg</td>
<td>Inches of Mercury (0°C)</td>
</tr>
<tr>
<td>24</td>
<td>cmH₂O</td>
<td>Centimeters of water (4°C)</td>
</tr>
<tr>
<td>25</td>
<td>inH₂O</td>
<td>Inches of water (4°C)</td>
</tr>
<tr>
<td>26</td>
<td>Torr</td>
<td>Torr</td>
</tr>
<tr>
<td>27</td>
<td>atm</td>
<td>standard atmosphere</td>
</tr>
</tbody>
</table>

**Distance/Length (33-48)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>mm</td>
<td>millimeters</td>
</tr>
<tr>
<td>34</td>
<td>cm</td>
<td>Centimeters</td>
</tr>
<tr>
<td>35</td>
<td>m</td>
<td>Meters</td>
</tr>
<tr>
<td>36</td>
<td>km</td>
<td>Kilometer</td>
</tr>
<tr>
<td>37</td>
<td>in</td>
<td>Inches</td>
</tr>
<tr>
<td>38</td>
<td>ft</td>
<td>Feet</td>
</tr>
</tbody>
</table>

**Coordinates (49-64)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>49</td>
<td>deg</td>
<td>Degrees</td>
</tr>
<tr>
<td>50</td>
<td>min</td>
<td>Minutes</td>
</tr>
<tr>
<td>51</td>
<td>sec</td>
<td>Seconds</td>
</tr>
</tbody>
</table>

**Conductivity (65-80)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>uS/cm</td>
<td>Microsiemens per centimeter</td>
</tr>
<tr>
<td>66</td>
<td>mS/cm</td>
<td>Millisiemens per centimeter</td>
</tr>
</tbody>
</table>

**Resistivity (81-96)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>81</td>
<td>ohm-cm</td>
<td>Ohm-centimeters</td>
</tr>
</tbody>
</table>

**Salinity (97-112)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>97</td>
<td>PSU</td>
<td>Practical Salinity Units</td>
</tr>
<tr>
<td>98</td>
<td>ppt</td>
<td>Parts per thousand salinity</td>
</tr>
</tbody>
</table>

**Concentration (113-128)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>113</td>
<td>ppm</td>
<td>Parts per million</td>
</tr>
<tr>
<td>114</td>
<td>ppt</td>
<td>Parts per thousand</td>
</tr>
<tr>
<td>115</td>
<td></td>
<td>(available)</td>
</tr>
<tr>
<td>116</td>
<td></td>
<td>(available)</td>
</tr>
<tr>
<td>117</td>
<td>mg/L</td>
<td>milligrams per liter</td>
</tr>
<tr>
<td>Id</td>
<td>Abbreviation</td>
<td>Units</td>
</tr>
<tr>
<td>----</td>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>118</td>
<td>µg/L</td>
<td>micrograms per liter</td>
</tr>
<tr>
<td>119</td>
<td>---</td>
<td>(deprecated, no longer available, was uM/L; was used but invalid)</td>
</tr>
<tr>
<td>120</td>
<td>g/L</td>
<td>grams per liter</td>
</tr>
<tr>
<td>121</td>
<td>ppb</td>
<td>Parts per billion</td>
</tr>
</tbody>
</table>

**Density (129-144)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>129</td>
<td>g/cm³</td>
<td>Grams per cubic centimeter</td>
</tr>
</tbody>
</table>

**pH (145-160)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>145</td>
<td>pH</td>
<td>pH</td>
</tr>
</tbody>
</table>

**Voltage (161-176)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>161</td>
<td>µV</td>
<td>micro Volts</td>
</tr>
<tr>
<td>162</td>
<td>mV</td>
<td>milli Volts</td>
</tr>
<tr>
<td>163</td>
<td>V</td>
<td>Volts</td>
</tr>
</tbody>
</table>

**Dissolved Oxygen (DO) % Saturation (177-192)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>177</td>
<td>% sat</td>
<td>Percent saturation</td>
</tr>
</tbody>
</table>

**Turbidity (193-208)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>193</td>
<td>FNU</td>
<td>formazin nephelometric units</td>
</tr>
<tr>
<td>194</td>
<td>NTU</td>
<td>nephelometric turbidity units</td>
</tr>
<tr>
<td>195</td>
<td>FTU</td>
<td>formazin turbidity units</td>
</tr>
</tbody>
</table>

**Flow (209-224)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>ft³/s</td>
<td>Cubic feet per second</td>
</tr>
<tr>
<td>210</td>
<td></td>
<td>Available (was Cubic feet per minute)</td>
</tr>
<tr>
<td>211</td>
<td></td>
<td>Available (was Cubic feet per hour)</td>
</tr>
<tr>
<td>212</td>
<td>ft³/day</td>
<td>Cubic feet per day</td>
</tr>
<tr>
<td>213</td>
<td>gal/s</td>
<td>Gallons per second</td>
</tr>
<tr>
<td>214</td>
<td>gal/min</td>
<td>Gallons per minute</td>
</tr>
<tr>
<td>215</td>
<td>gal/hr</td>
<td>Gallons per hour</td>
</tr>
<tr>
<td>216</td>
<td>MGD</td>
<td>Millions of gallons per day</td>
</tr>
<tr>
<td>217</td>
<td>m³/sec</td>
<td>Cubic meters per second</td>
</tr>
<tr>
<td>218</td>
<td></td>
<td>Available (was Cubic meters per minute)</td>
</tr>
<tr>
<td>219</td>
<td>m³/hr</td>
<td>Cubic meters per hour</td>
</tr>
<tr>
<td>220</td>
<td></td>
<td>Available (was Cubic meters per day)</td>
</tr>
<tr>
<td>221</td>
<td>L/s</td>
<td>Liters per second</td>
</tr>
<tr>
<td>222</td>
<td>ML/day</td>
<td>Millions of liters per day</td>
</tr>
<tr>
<td>223</td>
<td>mL/min</td>
<td>milliliters per minute</td>
</tr>
<tr>
<td>Id</td>
<td>Abbreviation</td>
<td>Units</td>
</tr>
<tr>
<td>----</td>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>224</td>
<td>kL/day</td>
<td>Thousands of liters per day</td>
</tr>
</tbody>
</table>

**Volume (225-240)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>225</td>
<td>ft³</td>
<td>Cubic feet</td>
</tr>
<tr>
<td>226</td>
<td>gal</td>
<td>Gallons</td>
</tr>
<tr>
<td>227</td>
<td>Mgal</td>
<td>Millions of gallons</td>
</tr>
<tr>
<td>228</td>
<td>m³</td>
<td>Cubic meters</td>
</tr>
<tr>
<td>229</td>
<td>L</td>
<td>Liters</td>
</tr>
<tr>
<td>230</td>
<td>acre-ft</td>
<td>Acre feet</td>
</tr>
<tr>
<td>231</td>
<td>mL</td>
<td>milli Liters</td>
</tr>
<tr>
<td>232</td>
<td>ML</td>
<td>Millions of liters</td>
</tr>
<tr>
<td>233</td>
<td>kL</td>
<td>Thousands of liters</td>
</tr>
<tr>
<td>234</td>
<td>Acre-in</td>
<td>Acre inches</td>
</tr>
</tbody>
</table>

**% (241-256)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>241</td>
<td>%</td>
<td>Percent</td>
</tr>
</tbody>
</table>

**Fluorescence (257-272)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>257</td>
<td>RFU</td>
<td>Relative Fluorescence Units</td>
</tr>
</tbody>
</table>

**Low-Flow (273-288)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>273</td>
<td>ml/sec</td>
<td>milli liters per second</td>
</tr>
<tr>
<td>274</td>
<td>ml/hr</td>
<td>milli liters per hour</td>
</tr>
<tr>
<td>275</td>
<td>l/min</td>
<td>Liters per minute</td>
</tr>
<tr>
<td>276</td>
<td>l/hr</td>
<td>Liters per hour</td>
</tr>
</tbody>
</table>

**Current (289-304)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>289</td>
<td>uA</td>
<td>Micro Amps</td>
</tr>
<tr>
<td>290</td>
<td>mA</td>
<td>Milli Amps</td>
</tr>
<tr>
<td>291</td>
<td>A</td>
<td>Amps</td>
</tr>
</tbody>
</table>

**Velocity (305-320)**

<table>
<thead>
<tr>
<th>Id</th>
<th>Abbreviation</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>305</td>
<td>ft/s</td>
<td>Feet per second</td>
</tr>
<tr>
<td>306</td>
<td>m/s</td>
<td>Meters per second</td>
</tr>
</tbody>
</table>

**Appendix D - Register Data Formats**

The Modbus protocol specification requires any multiple-byte data type to be transmitted in Big Endian order, or most significant byte (MSB) first. In-Situ devices shall use the following register data formats.

**Register Data Type Table**

<table>
<thead>
<tr>
<th>Id</th>
<th>Type</th>
<th>Size (registers)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Unsigned Short</td>
<td>1</td>
<td>2 bytes, 1 register, MSB first</td>
</tr>
<tr>
<td>5</td>
<td>Float</td>
<td>2</td>
<td>4 bytes, 2 registers, IEEE floating point format</td>
</tr>
</tbody>
</table>